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Assignments for GIS Tutorial 1 for ArcGIS® Pro: A Platform Workbook
Chapter 1
Assignment 1-1: Analyze the change in population by county in the United States from
2000 to 2010
In this assignment, you’ll generate maps and statistics for the top 10 US counties for
both increases and decreases in population from 2000 to 2010. In addition, you’ll export images
for maps and capture some screen prints of tables for use in a short Microsoft Word report that
you’ll write. You’ll also publish the map on ArcGISSM Online.
Note that after you complete the tutorials on Esri® Story Maps in chapter 3, the material
you generate in this assignment makes good content for a story map. So, if you want an
additional exercise to build a story map, revisit this assignment.
Get set up
Start by renaming the Assignment1-1 project home folder to include your name, and
then open its project file.


Open Windows Explorer or File Explorer and browse to Chapter1. Rename the Assignment11 folder to Assignment1-1YourName with no blank spaces (for example, Assignment11MarySmith).



Then double-click the Assignment1-1YourName folder, and double-click Assignment11.aprx. That opens ArcGIS® Pro with your project, which has no content yet.

Build maps
Next, you must create a new map in your project.


Click Insert > New map. This creates a map called Map.



Open the Catalog pane, expand Maps, right-click Map, click Rename, and type Top 10
Population Increases by County.
Next, you will add map feature classes to your map.



Click the Map tab > Add Data button.
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Browse to Chapter1\Assignment1-1YourName\Assignment1-1.gdb, hold down the Shift key,
and click Select to add the USCounties and USStates feature classes. If USStates is not
already on top, drag that feature class to the top of the Contents pane.



Zoom to the lower 48 states, and create a bookmark called Lower 48 States.
The added feature classes have default symbolization. Symbolize them as follows:



For USStates, use no color for fill and a dark gray outline with width 1 pt.



For USCounties, use white as the color for fill and a medium gray outline of width 0.5 pt.
Some additional mapping steps are:



Click USStates in the Contents pane, click it again to get into change mode, and change the
name to States. Similarly, change USCounties to Counties.



Label states with their names. Use a 7 pt font and a 1 pt white halo. You will notice some
states have more than one label.



Under the Labeling tab, click Label Placement > the dialog launcher at the lower right > the
Conflict Resolution button

> Remove duplicate labels > Remove all.

Open the Fields view of Counties, place attributes in the order as seen below, make only
those attributes visible, and type aliases as follows. Remember to save changes.


Geography = county and state names, for example, Fayette County, Texas (alias County)



POP2000 = population in 2000 (alias Population 2000)



POP_2010 = population in 2010 (alias Population 2010)



POP_Change = POP_2010 – POP2000 = population change from 2000 to 2010 (alias
Population Change)
Make a copy of your map using the Catalog pane. Right-click Top 10 Population

Increases by County, click Copy, right-click Maps, click Paste. Rename the copy to be Top 10
Population Decreases by County.
Generate outputs
First, you’ll use the Windows Snipping tool to capture screen prints of data tables. Open
the Top 10 Population Decreases by County map, open the table for Counties, and sort the
table by Population Change, ascending. Use the following steps to capture an image of the
table.
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1. On your computer, search for Snipping Tool, and launch the program.
2. Drag a rectangle around the heading row with attribute aliases and first 10 data rows.
3. In the Snipping Tool, click File > Save As, and save to your assignment folder with the
name, Top10DecreasesTable, and JPEG file type.
Next, click Project > Options > Selection, set the selection color to a bright red, and
select the top 10 rows of the sorted County table. Close the table, and use the Snipping Tool to
capture the map with name, Top10DecreasesMap.JPG. Change the selection color to a bright
green, and in the Top 10 Population Increases by County map, capture the top 10 rows of data
and map image with names Top10IncreasesTable.JPG and Top10IncreasesMap.JPG.
Write a short report
Create a Microsoft Word document called Assignment1-1ReportYourName.docx for
your report, and save it in your Assignment1-1 folder. Start by pressing the Enter button in the
document to open up about two pages of lines. That makes it easier to insert tables and
images. Include the following parts for the report:


Title page with title and your name.



Short paragraph or paragraphs mentioning each exhibit in the following bullet. Briefly
discuss an observation of yours or some pattern for each exhibit, mentioning the exhibit by
name (for example, “See Exhibit 1 for …..”). Be brief!



Four exhibits: Exhibit 1 has the table of the 10 biggest decreases, Exhibit 2 has the map of
the 10 biggest decreases, Exhibit 3 has the table of the 10 biggest increases, and Exhibit 4
has the map of the 10 biggest increases. Each exhibit needs a caption at the top, for
example, Exhibit 1. Ten counties with the biggest decreases in population from 2000 to
2010.
You can easily insert your map image for counties with large population decreases into

the Microsoft Word document.


In Word, click Insert > Pictures, browse to your folder, and insert Top10DecreasesTable.jpg
into your Word document below Exhibit 1. Resize the map by dragging its lower right
corner.
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Now repeat all steps for the table and map image for population increases. Finish
writing the report.
Publish your map
Remove selections from one of your maps, and publish the map to ArcGIS Online with
the name Population_Changes_YourName. Open your map online, and select the top 10
counties for increases in population.
What to turn in
Turn in your Assignment1-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 1-2: Produce a neighborhood block watch crime map
In this assignment, you prepare a PowerPoint presentation for a neighborhood block
watch. The presentation includes a map of 911 emergency calls for a number of crime types as
well as a corresponding list of crimes.
Get set up
Rename the Assignment1-2 project home folder to include your name, and open its
project file.


Open Windows Explorer or File Explorer and browse to Chapter1. Rename the Assignment12 folder to Assignment1-2YourName with no blank spaces (for example, Assignment11MarySmith).



Double-click the Assignment1-2YourName folder, and double-click Assignment1-2.aprx,
which opens ArcGIS Pro® with your project.

Build the map
Start by creating a new map in your project.


Click Insert > New Map, which creates a map called Map.



Rename the map Block Watch.
Now add map feature classes to your map.



Remove the Topographic basemap from Contents, and do not use any other basemap for
this assignment. The coordinate system of the feature classes you will add is not a standard
one and so will not align with basemaps.



Add the following feature classes to the map from Chapter1\Assignment12YourName\Assignment1-2.gdb: Bldgs, CADCalls, Curbs, Streets, Outline.



CADCalls, the subject of the map, has point features for 911 computer-aided dispatch police
calls in the Middle Hill neighborhood of Pittsburgh. Attributes of interest include





Nature_Code = call type code



CallDate = date of incident



Address = address of incident location.

Bldgs has polygon features for building footprints (digitized rooftops from aerial
photographs) in the Middle Hill. Bldgs is used for spatial context.

6



Curbs has line features for curbs in the Middle Hill. Curbs was also digitized from aerial
photographs and is for spatial context, showing the actual shapes and widths of streets.
Curbs does not have street names, so you will also need the next feature class.



Streets has line features for street centerlines in the Middle Hill. The streets are so-called
TIGER streets from the US Census Bureau. Each street feature is one block long and has a
street name plus starting and ending street numbers on both the left and right sides of
streets. This feature class is needed for its street name attribute, FName, to label curbs.



Outline is a polygon feature class with the boundary of the Middle Hill neighborhood.

Symbolize the map
A fundamental cartographic principle for thematic maps (that is, maps with a specific
purpose) is to give the subject features bright colors to draw attention to them while making
spatial context feature classes drab colors, mainly grays. Also, providing clearly and plainly
written, self-documenting labels is always a good idea for maps and any graphics.


Symbolize CADCalls as bright red Circle 3 point markers, size 6 pt.



Symbolize Outline with no color and 80% gray outline, size 1.5.



Symbolize Bldgs with no color for border and 50% gray color. Display Curbs as 30% gray with
0.5 pt line width, and streets with no color. You’ll not display Streets but will use street
names to label curbs in the next bullet.



Label streets using the FName field. Use a 70% gray font color, size 7. Add a white halo with
no boundary, size 0.5. Click Label Placement, and select European Streets to place labels on
the street centerlines.



Add aliases for the attributes listed above and rename feature classes in the Contents pane
with plain English labels.

Identify the block watch
The block watch is a single block, but of course any crime prevention efforts will impact
not only residences and businesses in the block, but those in adjacent blocks as well.


Make CADCalls and Curbs the only selectable feature classes. Make the selection color a
bright blue.
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Zoom into the Perry/Elmore block watch, which is the block bounded by Webster, Elmore,
Wylie, and Perry streets. Create a bookmark, called Perry/Elmore Block Watch, of the
zoomed-in area.



Select the curbs of the Perry/Elmore block watch. You should have one Curbs record
selected that outlines the block.



Use your Perry/Elmore Block Watch bookmark.

Provide information for analyzing the block watch
Use the following steps to capture a screen print of your map.
1. On your computer, search for Snipping Tool, and launch the program.
2. Drag a rectangle around the map.
3. In the Snipping Tool, click File > Save As, and save to your assignment folder with the
name, BlockWatchMap and JPEG file type.
Besides the map, the presentation also needs a table of crimes that occurred in and
near the block watch.


Hold down the Shift key and carefully select each CAD Call point within the block watch as
well as all calls in or near buildings facing the block-watch streets in the adjacent four blocks
(hint: there are four relevant calls in adjacent blocks). Sort the selected rows by CallDate
descending.



Use the Snipping Tool to capture a screen print of the selected rows of data called
BlockWatchTable.jpg.

Create a Microsoft PowerPoint document
Create a PowerPoint presentation called Assignment1-2YourName.pptx that includes
three slides:


Title slide including your name



Slide with map of Perry/Elmore Block Watch including the exported map of crimes



Excel table listing the call type, address, and date
Click Design > Customize > Slide Size > Standard (4:3).
For the map slide, in PowerPoint click Insert > Pictures, browse to your assignment

folder, and insert BlockWatchMap.jpg. To put a boundary on the map, right-click the map, and
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click Format Picture > the bucket icon > Line > Solid line and black for color. Also insert
BlockWatchTable.jpg.
What to turn in
Turn in your Assignment1-2YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 2
Assignment 2-1: Analyze accessibility to charter schools in New York City
Suppose that a philanthropic foundation wants to study the role of public charter
schools in New York City, including student access to public charter schools and the proximity of
charter schools to public and private schools. In the initial GIS project, you will create a map
showing all schools using various point symbols and colors.
The design for this map uses two levels of codes from attributes available for the
schools map layer. The first code is school type (public, public charter, and private). The second
code is grade level (for example, elementary, middle, junior, and high school). To handle this
complexity, you will create group layers, one for each school type, and each group layer will use
unique symbols for grade level. In this chapter, you completed separate tutorials for creating
group layers and symbolizing with unique symbols. In this assignment, you will use both designs
in the same map.
For comparison, you’ll use different colors for school types. You’ll make public charter
schools figure features and place private schools closer to ground features. You will use unique
symbols for each school category (for example, all elementary schools use circles, all middle
schools use triangles, all high schools use squares, and so on.) Layer groups allow you to easily
package and share school studies with others.
Get set up
Start by renaming the Assignment2-1 project home folder to include your name, and
then open its project file.


Rename the Assignment2-1 folder to Assignment2-1YourName in Chapter2.



Open Assignment2-1.aprx in that folder, which has no content as yet.

Build maps


Insert a new map, and rename the map New York City School Types.



Remove the Topographic basemap.

Add and symbolize map layers


Add the following feature classes from Chapter2\Assignment2-1YourName\Assignment21.gdb: Boroughs, Schools, SchoolDistricts, and Water.
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Symbolize Boroughs with no color fill, black outline, width 1.15.



Label the boroughs using BoroName, a light-yellow halo mask, bold, and size 12.



Symbolize SchoolDistricts with no color, Ultra Blue outline color, width 1.5.



Symbolize Water with light-blue color and no outline.
Create a bookmark for the five Boroughs, zoomed approximately to each borough.

Create group layers


Create three group layers called PublicCharterSchools, PublicSchools, and
PrivateParochialSchools, each including the four layers added earlier. Create tags, a
summary, and description for each layer group. Hint: Copy and paste to place layers in the
other layer groups.



Create definition queries for the Schools in each group layer. Knowledge of which attribute
ranges to include in query criteria came from documentation provided by the data source.





Public Charter Schools "Facility_T" > = 1011 And "Facility_T" < = 1017



Public Schools "Facility_T" > = 1001 And "Facility_T" < = 1006



Private/Parochial Schools "Facility_T" > = 1101 And "Facility_T" < = 1106

In each group layer, use unique symbols for school _type (the Factype__1 code description
attribute) symbolized as follows. Note: Some school types overlap in terms of school grades
included (such as Middle School. Junior High, and Intermediate/Junior High School) and thus
have similar or the same symbols (various triangles for the examples just cited).


Elementary School (public charter/public/private/parochial): Circle1, size 10



Middle School (public/private/parochial): Triangle1, size 12



Junior High (private/parochial): Triangle4, size 12



Intermediate/Junior High School (public charter/public): Triangle4, size 12



Junior/Senior High School (public charter/public/private/parochial): Square5, size
10





High School (public charter/public): Square1, size 10



Senior High School (private/parochial): Square1, size 10



K-12 School (public charter/public/private/parochial): Star3, size 14

Remove all other values.
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Use Mars Red color for all public charter school symbols, Gray 30 percent color for all public
schools, and Soapstone Dust color for all private schools. This emphasizes public charter
schools by making them figure features.



Save the layer groups as layer packages to the Assignment2-1YourName folder called
PublicCharterSchools.lpkx, PublicSchools.lpkx, and PrivateParochialSchools.lpkx.



Save your project with only the Public Charter Schools layer turned on and zoomed to the
Brooklyn bookmark.

What to turn in
Turn in your Assignment2-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 2-2: Study K-12 population versus school type densities
New York City is the most densely populated city in the United States. Over 8 million
people live in an area of about 300 square miles. According to the 2010 census, many
neighborhoods have over 10,000 children ages 5-17. A detailed study of school types and
population by neighborhoods would be useful to show where existing schools are located
relative to K-12 age population. In this assignment, you will create choropleth maps comparing
the density of public, public charter, and private schools by neighborhoods. You will add point
symbols for each neighborhood showing the percentage of K-12 population.
Note that while you create just one map, to use the results in a report or website, you
would produce three separate map outputs, one for each school type. In chapter 3, you will
learn how to create map layouts and Esri Story Maps websites, two good forms of output for
this assignment.
Get set up
Start by renaming the Assignment2-2 project home folder to include your name, and
then open its project file.


Rename the Assignment2-2 folder to Assignment2-2YourName in Chapter2.



Open Assignment2-2.aprx in that folder, which has no content as yet.

Build the map


Insert a new map and rename it NYC K-12 School and Population Study.



Remove the Topographic basemap.

Add and symbolize map layers


Add the following feature classes from Chapter2Assignment2-2YourName\Assignment22.gdb: Boroughs, Neighborhoods, NeighborhoodCentroids, and Water.


Symbolize Boroughs with no color, black outline, width 1.15. Label the boroughs
using BoroName, a light-yellow halo mask, bold, size 10. Remove all duplicate
labels.



Symbolize Water with light-blue color, no outline.



Symbolize NeighborhoodCentroids point features as graduated symbols to show
the K-12 population (Pop_5_17) normalized by the total population (Tot_Pop).
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Label using a percentage (not a fraction), logical classifications, symbols, and
color.
Add or copy Neighborhoods three times as display as choropleth maps normalized using
fields Public, Private, and PubCharter (the number of schools in each neighborhood) /
Area_SqMi to show the density of school type by neighborhood. Think carefully about custom
classifications, colors, and polygon outline choices. The objective is to compare school types
using a single numerical scale for break points. Hint: there are fewer public charter schools than
public or private. Take this into consideration when choosing classes, number of classes, and
colors for each layer.


Rename all layers with descriptive names based on the map content.

What to turn in
Turn in your Assignment2-2YourName folder for grading, according to instructions
provided by your instructor.

14

Assignment 2-3: Analyze military sites for closures by congressional district
BRAC (Base Realignment and Closure) is a process of the federal government used by
the Department of Defense (DoD) and Congress to close and realign military installations to
reduce expenditures and achieve increased efficiency. At the same time, members of Congress
attempt to keep military installations open in their districts or states as sources of employment
and economic activity. More than 350 installations have been closed in five BRAC rounds since
1989, and a round was completed in November 2005. A 2005 commission recommended that
Congress authorize another BRAC round in 2015, and then every eight years thereafter. GIS is
an effective tool in regard to BRAC to visualize and analyze military installations and
congressional districts in the United States.
Get set up
Start by renaming the Assignment2-3 project home folder to include your name and
then open its project file.


Rename the Assignment2-3 folder to Assignment2-3YourName in Chapter2.



Open Assignment2-3.aprx in that folder, which has no content as yet.

Build the map


Insert a new map and rename it DoD Military Base Study.



Change the basemap to a light-gray canvas and remove the World Light Gray Reference
layer.

Add map layers and create layer groups


Add the following features from Chapter2Assignment2-3YourName\Assignment2-3.gdb:
USStates, USCities, Congress111, MilitaryBnd, and MilitaryPT.



Create three group layers called DoD Count by 111 Congress, DoD Installation by Military
Type, and BRAC Status and Political Party. Create tags, a summary, and description for each
layer group. Zoom to the 48 contiguous US states in all three layer groups and create a
bookmark of this zoomed area.

Symbolize layers


In the DoD Count by 111 Congress layer group, add layers Congress111 and US States
symbolized as follows:
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USStates with no color and a dark gray outline, 1.5 pt. Label the states using the
state abbreviation (STUSPS) using a yellow halo and duplicate labels removed.



111th Congress as a choropleth map showing the number of DoD installation
(DoD_Count) by congressional district using logical classes and colors.




Rename all layers logically.

In the DoD Installation by Military Type layer group, include layers with the following
symbols:


USStates copied and pasted from the first layer group.



USCities whose 2007 populations (Pop2007) are greater than or equal to 250,000
and labeled with a light gray, italic font.



MilitaryBnd polygons (DoD installations) as unique symbols using the Component
field. Group the component colors based on the types. Use different shades of
purple for Air Force, blue for Navy, drab green for Army, orange for Marine Corps,
and gray for Washington Headquarters Service. When choosing colors, focus on
the active installations by making their colors darker than guard or reserve
installations. This will draw attention to these active installations. Remove all
other values.



Zoom to the southwest states (California, Nevada, Utah, and Arizona) and create
a spatial bookmark called Southwest DoD Installations.




Rename all layers logically.

In the BRAC Status and Political Party layer group, include layers with the following symbols:


USStates copied and pasted from the first layer group.



MilitaryPt points (DoD installations) as unique symbols using the BRAC_Site field.
Use a black square for No and bright red circle for Yes.



111th congressional districts as unique symbols using the Party field. Use a drab
red, medium-gray outline for Republican and a drab blue, medium-gray outline
for Democrat. Remove null or other values.
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Save layer packages


Save the layer groups as layer packages to the Assignment2-3YourName folder called
BRACStatusPoliticalParty.lpkx, DoDCountBy111Congress.lpkx, and
DoDInstallationByType.lpkx.

What to turn in
Turn in your Assignment2-3YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 2-4: Analyze US veteran unemployment status
The US Census collects data about US veterans and their dependents. In this
assignment, you will create a choropleth map showing the unemployment status of veterans in
the labor workforce by US county. The data for these maps are 2009 three-year estimates from
the American Community Survey. Some counties are not populated enough and have no data.
You will display these counties as a light-gray polygon.
Get set up
Start by renaming the Assignment2-4 project home folder to include your name and
then open its project file.


Rename the Assignment2-4 folder to Assignment2-4YourName in Chapter2.



Open Assignment2-4.aprx in that folder, which has no content as yet.

Build a map


Insert a new map and rename it Unemployed Veterans Study.



Change the basemap to a light-gray canvas.



Add the following features from Chapter2\Assignment2-4YourName\Assignment2-4.gdb:
USStates, and USCounties.



Zoom to the lower 48 contiguous states, and save the zoom as a bookmark called 48
Contiguous States.

Symbolize layers


Symbolize USStates with no color, dark gray outline, width 1.5, and rename the layer.



Label the states using the state abbreviation (STUSPS) using a yellow halo, bold font, and
duplicate labels removed.



Symbolize USCounties as a choropleth map, normalized showing the percentage of
unemployed veterans in the labor workforce (using the fields VetUnempl and
Vet_LbrForce). Use a logical mathematic progression and good colors/color outlines. Think
carefully about your symbology and method choices. Use the Histogram view to understand
the distribution of the data and guide you. Edit the legend symbology to show the numbers
as percentages. Rename the layer. Hint: There are many counties with no data. To show
these, in the Symbology pane click More and click “Show values out of range”. Symbolize
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these as Artic White fill color and Gray (30 percent) outline. Rename the label to reflect it
contains no data.
What to turn in
Turn in your Assignment2-4YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 3
Assignment 3-1: Build a layout with income versus educational attainment in
Washington, DC
Generally higher educational attainment leads to better-paying jobs. You’ll create a map
layout in this assignment comparing per capita income versus percent of population with a
bachelor’s degree or higher in Washington, DC, by census tract. You’ll see which parts of
Washington, DC, have high and low income and educational attainment, plus see a scatterplot
of those two attributes.
Note that assignment 3-4 has you build a story map for this same case. There you can
use the report that you write for this assignment in Microsoft Word as a manuscript, which will
just need minor editing for the non-map content of the story map.
Get set up
 Open Windows Explorer or File Explorer and browse to Chapter3\. Rename the
Assignment3-1 folder to Assignment3-1YourName.


Then open the Assignment3-1.aprx in your assignment folder to open the project. The
project is empty and has no map.

Map requirements
 Add Chapter3\Assignment3-1YourName\Assignment3-1.gdb\DCTract2010 (polygons for DC
tracts) and DCTracts2010Points (centroids for DC tracts) to your map document. Both layers
include the following attributes:


GEOID10 = census tract number



PerCapInc = per capita income



PopBachDeg = percentage of population 25 or older with bachelor’s degree or
higher

Turn off visibility of all fields except GEOID10, PerCapInc, and PopBachDeg. Give the
visible fields good aliases. Make a choropleth map layer for PerCapInc and a graduated symbol
map layer for PopBachDeg, both on the same map and both with good numeric scales and color
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schemes. Remove the basemap. Edit labels for numeric classes to state intervals (for example,
“10 to 20”), and round values to at most one decimal place. Give your map a descriptive name.
Layout requirements
In the layout include the map, a legend, and “Map by your name” at the bottom right of
the layout. Share your layout as an exported JPEG image called DCIncomeEducation.jpg to your
assignment folder. Customize the legend so that extra text is eliminated and all labels are
written in clear and simple language.
Write a short report in Microsoft Word with title, your name and date, short paragraph
discussing the relationship between per capita income and educational attainment in
Washington. Include your map and scatterplot (described below), labeling them as Figures 1
and 2 with descriptive captions. Refer to both figures in text (for example, “Figure 1 is a map
showing…”). Name your document Assignment3-1YourName.docx, and save it in the
assignment folder.
Make a scatterplot of PerCapInc versus PopBachDeg (with the dependent variable,
PerCapInc on the vertical axis). See tutorial 3-4, if needed, on how to use Microsoft Excel to
create the chart. Paste it directly from Excel into your report.
Extra credit:
If you’ve had a statistics course and know about regression analysis, you can estimate a
straight line relationship between PerCapInc and PopBachDeg using Microsoft Excel.


First add the Analysis Toolpak to your Excel interface (the availability of the Toolpak
depends on your license for Microsoft Office).



Click File > Options > Add-ins > Analysis Toolpak > Go > Analysis Toolpak > OK.



Then run the regression model: Click Data > Data analysis > Regression > OK > Labels >
select Y (PerCapInc) and X (PopBachDeg) ranges including labels at top of each column > OK.



Paste the regression output into your report.
The output includes that estimated per capita income for a neighborhood with 0

percent attainment of a bachelor degree or higher of $28,082, an increase of $522 for each
percent increase in that educational attainment, and therefore an estimate of $75,308 for a
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neighborhood with 100 percent attainment. You’d also find that both the estimates $23,082
and $522 are highly statistically significant.
What to turn in
Turn in your Assignment3-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 3-2: Build a map layout for comparing 2D and 3D maps for urgent health
care clinics in Pittsburgh
Chapter 1 used 2D and 3D maps of Allegheny County, Pennsylvania, and its City of
Pittsburgh to visualize the geographic accessibility of populations to urgent health care clinics.
This assignment has you use those maps to create a layout that helps explain the spatial
clustering of Federally Qualified Health Care (FQHC) clinics in certain parts of Pittsburgh. While
a choropleth map of population density shows areas with high density, it fails to depict how
very much higher population density is for certain areas. In fact, population density has a
distribution highly skewed to the right, so that there are areas with dramatically higher
densities than other areas. The 3D map of population density depicts this extreme with
polygons extruded vertically by population density. It’s in such areas that you can expect to see
FQHCs clustered close together. Any FQHC has limited capacity to serve patients, so that more
than one FQHC is needed in relatively close proximity for high population areas.
Get set up
Start by renaming the Assignment3-2 project home folder to include your name and then open
its project file.
Requirements
Create a layout with both maps that meets the following elements:


ANSI-Portrait Letter 8.5" x 11" layout. Hint: Use the New layout button under the Insert tab,
Project section to create your layout. It provides options for layout sizes and orientations.



Both maps, same size, aligned left.



One legend based on the 2D map, customized with plain-English labels.



Text with subtitles for each map, aligned left (no layout title).



Text with your name (for example,“Map by Mary Smith,” lower right, small font size).

23



Microsoft Word document with title at top of page, short paragraph explaining the purpose
of the map, map inserted as an image with figure caption typed in Microsoft Word at top
above the image. The text must refer to the figure (for example, “See Figure 1 for the
map.”)

What to turn in
Turn in your Assignment3-2YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 3-3: Build a story map for locating charter schools in New York City
Public charter schools provide an alternative to public schools. Charter schools are free,
open to all children, often focus on a theme, for example, STEM (science, technology,
engineering, and mathematics), environment, arts, college preparation, and so on. Charter
schools generally serve higher percentages of minority and/or low-income students than public
schools. While having more freedom to innovate than public schools, charter schools are held
accountable for student performance.
This assignment has you build a story map for identifying neighborhoods in New York
City that could possibly benefit from having one or more additional charter schools. The same
story map is also useful for families looking for neighborhoods that have charter schools.
The Assignment3-3 project has two maps ready for you to publish in your ArcGISSM
Online account. One has the number of school-age children and the other has the number of
school-age children living in poverty as choropleth maps by neighborhood. Both maps have the
number of schools in three categories: public, private, and public charter schools plotted as
size-graduated point symbols. The break points and sizes of point symbols across the three
school types are the same (created using the Manual Interval method), facilitating comparisons.
Note that the story map for this assignment only provides the first, macro level
assessment of public charter schools in an urban area. A good GIS project (not included in this
assignment) would be to add individual schools as points, including data on student enrollment.
Data is available for download from the National Center for Education Statistics
(http://nces.ed.gov/ccd/), which was the school data source for this assignment. The maps of
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this assignment would also display individual schools when zoomed into neighborhoods. Popups for schools could include school websites. Also, demographic data from the American
Community Survey (see chapter 5) at the census-block-group level would provide a spatial
breakdown of school-age population because block groups are relatively small areas of about
1,000 population. You could build such a story map for any city in the United States.
Get set up
Start by renaming the Assignment3-3 project home folder to include your name and
then open its project file. Add any new files you create to the
Chapter3\Assignment3-3 home folder for the project.
Zoom to the New York City bookmark for each map. Publish the maps to your account.
Create a new folder called Assignment3-3YourName at ArcGIS Online, and move your
published maps to that folder.
Requirements
Do additional work on the two published maps.


Use the Filter button

in ArcGIS Online to create definition queries so that point symbols

are only displayed for neighborhoods with one or more schools of each type. An example
filter for public charter schools is PubCharter is greater than 0. Include similar filters for
public schools and private schools. Do filtering for both maps.


Configure pop-ups for each map. Have no pop-ups for school layers and boroughs, but
include a pop-up for School Age Population and School Age Population in Poverty layers in
respective maps. Include BoroName, Name, Public, PubCharter, Private, Pop18Under, and
PopPov18 Under. The result will be pop-ups that are easy to use (in other words, click
anywhere in a neighborhood).



Label neighborhoods with neighborhood name.
Create a story map with a side accordion layout (start by going to http://Story

Maps.arcgis.com/en/app-list/). You need a section for each of the two maps you published.
Include legends for both maps. Create your text in a Microsoft Word document. Format your
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text with bold font, font size, and so on as needed in Word. Use bulleted or numbered lists
wherever possible. Then copy and paste into the Story Map editor. Include the following
information in the text:


Purpose of the story map.



Nature of public charter schools with hyperlinks to two good websites.



Instructions on how to navigate and use the maps.



Table with the top candidate neighborhoods for getting a new charter school and
explanation of your criteria or approach for selecting them. Hints: limit columns to Name,
Population under 18, public schools, and private schools. No need to include public charter
schools because they all have value 0. Also, in Microsoft Excel, you can make columns
narrow by allowing text to wrap to a new row. Select a column, right-click in the selection,
click Format cells > Alignment, check Wrap text, and select Top for Vertical.



Break text into sections with headings.

What to turn in
If you are in a class and need to turn in your story map for grading, then use the
following steps:
1. Open arcgis.com in your browser, sign in, and go to Content.
2. On the My Content tab, click the ellipsis to the right of your listed story map, and click
View item details.
3. Copy the long URL under Properties, and paste it into a Microsoft Word document with
the name MyStoryMapURLYourName.docx.
4. Turn in the Word document. Your instructor will be able to open your story map by
using the URL.
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Assignment 3-4: Build a story map for income versus educational attainment in
Washington, DC
To work this problem, you need to have first worked assignment 3-1. Use the Word
document you created in assignment 3-1 as the start of the manuscript for non-map content
here. Use the Windows Snipper (see tutorial 3-4) to create a JPEG image for the scatterplot of
per capita income versus educational attainment that you created in Excel, and use the image
for the story map.
Get set up
Rename the Assignment3-4 folder to Assignment3-4YourName and copy the content,
including your published map, from Assignment3-1 to this folder.
Do additional work in ArcGIS Pro
 Make ObjectID and Shape visible fields (in addition to the visible fields set in assignment 31) in DCTracts2010 and DCTracts2010Points (which is necessary for map publishing on
ArcGIS.com).


Add MajorRoads to the map and create a visibility range for it so that it and its labels (using
ST_NAME) turn on when zoomed in to about 25 percent of Washington.



Publish the map to your ArcGIS Online account with the name Story MapYourName.
Uploaded your scatter plot image to that folder and share it with everyone. Share all items
in this new folder with everyone.

Requirements
On ArcGIS.com, configure pop-ups for the published map. Have no pop-ups for
Educational Attainment, but include a pop-up for Per Capita Income. The result will be pop-ups
that are easy to use (for example, click anywhere in a neighborhood). Use all visible attributes
in the pop-up.
Create story map with the Story Map JournalSM web app. This layout is similar to the
side accordion layout in that it has a scrollable non-map content panel, but is for one map
instead of two or more. Start by going to http://Story Maps.arcgis.com/en/app-list/ and select
Build > the Side Panel layout > Start. Enter the title, Assignment 3-4 Story Map By Your Name.
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In the Add Home Section wizard, Step 1: Main Stage Content, with Map selected, select the
map you want to use, and for Extras be sure to select Overview map and Legend.
Non-map elements you need to include in the story map are the following:


Brief Instructions on how to use the map.



Edited text from your assignment 3-1 Word report.



Snipped image for the scatter plot of assignment 3-1.



Copy and paste the text from RegressionResultsManuscript.docx (which is in the assignment
folder) to the end of the non-map content.



Break text up with section headings.

What to turn in
If you are in a class and need to turn in your story map for grading, then use the
following steps:
1. Open arcgis.com in your browser, sign in, and go to Content.
2. On the My Content tab, click the ellipse to the right of your listed story map, and click
View item details.
3. Copy the very long URL under Properties and paste it into a Word document with the
name MyStoryMapURLYourName.docx.
4. Turn in the Word document. Your instructor will be able to open your story map by
using the URL.
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Chapter 4
Assignment 4-1: Investigate the spatial distribution of PhDs in Allegheny County
In this assignment you create a new ArcGIS project, import a census tract map and data
table into its file geodatabase, carry out several data utility and calculation steps, join the data
table to a tract map, and produce a map layout.
Create a new ArcGIS Pro project and map
Open ArcGIS Pro and create a Blank project called Assignment4-1YourName in the
Chapter4 folder. Make sure that the “Create a new folder for this project” checkbox is selected.
Those steps will create the home folder and its file geodatabase, Chapter4\Assignment41YourName\Assignment4-1YourName.gdb (Click Project > Options to verify this). Insert a new
map and rename it PhDs.
Set the spatial reference coordinate system for your map. In the Contents pane, rightclick PhDs, and click Properties Options > Coordinate system > Projected coordinate system >
State Plane > NAD 1983 (2011) (US Feet) > NAD 1983 (2011) State Plane Pennsylvania South
FIPS3702 (US Feet) > OK. You’ll learn about spatial coordinate systems in chapter 5.
Import data
Import the following layer into your file geodatabase:


Chapter4\Data\AlleghenyCounty\tl_2010_42003_tract10.shp. Rename the new layer
Tracts. GEOID10 is the tract geocode and it has the text data type. Delete all attributes
except GEOID10 and essential, grayed-out attributes.



Chapter4\Data\AlleghenyCounty\EducationalAttainment.csv as EducationalAttainment.
This is 2010 census tract data for Allegheny County on educational attainment. Leave all
attributes in the imported table. Next are some of the following attributes:


GEOid2 = tract geocode, numeric data type.



Female25_ = total female population 25 and older.
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FemaleDoctorateDegree = female population 25 or older with a doctorate degree
as highest educational attainment.



Data for males has similar names, starting with “Male” instead of “Female.”

Create new attributes
Create three new attributes in EducationalAttainment, all with the float data type.


PhDs = Population 25 or older (females and males) who have PhDs.



Pop25Plus = Population of females and males 25 or older.



PhDRate = Percentage of population 25 or older who have PhDs. Hint: Before calculating
PhDRate, select rows where Pop25Plus > 0. Otherwise you will get a warning message that
the calculation failed (in cases where the denominator of your expression was zero).
Calculate the values for the new attributes.

Join data and symbolize maps
Join EducationalAttainment to Tracts.
Symbolize your map as follows:


Use the Light Gray Canvas basemap.



Symbolize Tracts using seven quantiles and graduated colors for the attribute, PhDs.



In the Catalog pane copy and paste the PhDs map and rename the newly copied map to be
PhD Rate. Symbolize Tracts in the map using seven quantiles and graduated colors for the
attribute, PhDRate.
Create a layout called PHDs and Rates including both maps and two legends. Do not

customize legends by turning them into graphics and editing them (to save time), but nicely
align and size all layout objects. Do not include a map title, assuming that the layout would be
used in a Microsoft Word document report and have the figure number and caption typed
there.
What to turn in
Turn in your Assignment4-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 4-2: Compare serious violent crime with poverty in Pittsburgh
In the process of doing this assignment, you’ll build an ArcGIS project, import feature
classes and a standalone table into the project’s file geodatabase, add a domain to a table, join
census data to a feature class, and carry out a spatial join to aggregate point crime data to
crime counts per census tract. You’ll build a map layout for viewing the relationship between
serious violent crimes with poverty at the census tract level in Pittsburgh. Finally, you’ll be able
to use maps to zoom in to see individual crime points. Note that you need to have completed
tutorial 4-7 and in it created the UCRHierarchCode table to work this problem.
Get set up
Create a new ArcGIS Pro project and map.


Open ArcGIS Pro and create a Blank project called Assignment4-2YourName in the Chapter4
folder. Make sure that the “Create a new folder for this project” checkbox is selected.



Insert a new map and rename it Crimes.



Set the spatial reference coordinate system for your map. In the Contents pane, right-click
Crimes and click Properties Options > Coordinate system > Projected coordinate system >
State Plane > NAD 1983 (2011) (US Feet) > NAD 1983 (2011) State Plane Pennsylvania South
FIPS3702 (US Feet) > OK.

Import data
Import the following layers and table into your file geodatabase.


Chapter4\Data\Pittsburgh\PittsburghSeriousCrimesSummer2015.shp, a point shapefile of
serious crime offense locations in Pittsburgh during summer, 2015. If necessary, add the
imported layer to your map. Note that the year of crimes has been changed to protect
privacy. Note the included attributes:


Address = location of the offense.



CrimeDate = date of the offense.



Hierarchy = FBI UCR hierarchy code (1 = Criminal Homicide, 2 = Forcible Rape, 3 =
Robbery, 4 = Aggravated Assault, 5 = Burglary, 6 = Larceny-Theft, 7 = Motor
Vehicle Theft)
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Chapter4\Data\Pittsburgh\City.gdb\PghTracts, a polygon features of Pittsburgh 2010 census
tracts. GEOID10 (text data type) is the geocode for tracts. Note that this map layer has
several census attributes in it that you won’t use, but don’t delete them.



Chapter4\Data\Crime.gdb\UCRHierarchyCode.

Create a definition query
Create the following Definition Query for PittsburghSeriousCrimesSummer2015 (stated
in SQL below) for serious violent crimes only:
Hierarchy > = 1 AND Hierarchy < = 4
Because all of the needed codes are in a numeric range (1 to 4), it’s easier to build the
criterion with a range instead of a series of ORs naming each crime type.
Join data and symbolize maps
Join UCRHierarchyCode to PittsburghSeriousCrimesSummer2015, then each crime will
have its descriptive name as well hierarchy number. Symbolize this layer with unique symbols,
each with its own shape and color. Rearrange the symbols in the Symbology pane so that they
are in the order of Hierarchy, with Criminal Homicide first, Forcible Rape second, Robbery third,
and Aggravated Assault last.
Spatially join PittsburghSeriousCrimesSummer2015 to PghTracts to get a count of
serious violent crimes per tract in summer 2015. Remove all attributes of PghTracts in the
Output Fields panel except GEOID10. Name the output
PittsburghSeriousViolentCrimesSummer2015Tracts in your file geodatabase. Symbolize this
layer with graduated colors and 7 quantiles for Join_Count.
Add visibility ranges
Zoom into about 25 percent of Pittsburgh’s area and create visibility ranges so that the
choropleth map shuts off and the individual crime points turn on when zoomed to this scale.
The resulting map would be a good one to publish as a web map but would need additional
work that you won’t do here, so you’ll leave the map as an ArcGIS Pro desktop project.
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What to turn in
Turn in your Assignment4-2YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 4-3: Query statistics for day and night burglaries and larcenies by month
In this assignment, you’ll conduct a series of attribute queries on crime offenses to
investigate time-of-day of burglaries and larceny-thefts. A burglary takes place when a criminal
unlawfully enters a residence or business with the intent to take and keep anything of value,
depriving the owner of it. Even if nothing is taken but there was an unlawful entry and intent to
steal, a burglary is committed. A larceny-theft is the actual taking of something of value, but
without unlawful entry. We expect more burglaries during the day when residents are away at
work, but perhaps larcenies are more numerous at night under the cover of darkness.
You’ll find the distribution of burglaries and larcenies by day (7 a.m. to 7 p.m.) versus
night (7 p.m. to midnight and midnight to 7 a.m.) for each of the three months of summer 2015.
Once you have a few basic queries set up, you can run them, type frequencies in an Excel
spreadsheet, edit the queries, run them again, and so on.
Get set up
Create a new ArcGIS Pro project and map.


Open ArcGIS Pro and create a Blank project called Assignment4-3YourName in the
Chapter4 folder. Make sure that the “Create a new folder for this project” checkbox is
selected.



Insert a new map and rename it Burglaries.



Set the spatial reference coordinate system for your map. In the Contents pane, right-click
Burglaries, and click Properties Options > Coordinate system > Projected coordinate system
> State Plane > NAD 1983 (2011) (US Feet) > NAD 1983 (2011) State Plane Pennsylvania
South FIPS3702 (US Feet) > OK.
Import data into your file geodatabase:

 Chapter4\Data\Pittsburgh\City.gdb\CrimeOffenses
 Chapter4\Data\Pittsburgh\City.gdb\Pittsburgh
Run select by attribute queries
Don’t use file definition queries; instead use select by attribute queries. Save your query
for Total June 2015 Burglaries as TotalJuneBurglaries and your query for June 2015 Day
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burglaries as DayJuneBurglaries, both in Chapter4. Don’t save any other queries, just run them
and get results.
Open the Excel workbook, Chapter4\Data\Assignment4-3.xlsx and save it to your
Assignment4-3YourName folder. Type queried Day frequencies and totals in appropriate cells.
The spreadsheet will calculate Night frequencies by difference (Total – Day) and also calculate
percentages using cell expressions.

Hint: Calculating Night frequencies by difference (Total–Day) saves you time in terms of
the number of queries you run (half as many), but you have to think carefully about how to
query the totals for your spreadsheet. Check the query results for a total and ensure you have
the right value by looking at crimes and dates.
Copy and paste the SQL for TotalJuneBurglaries.exp and DayJuneBurglaries.exp at the
bottom of your spreadsheet.
Run similar queries for July and August to complete the spreadsheet.
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What to turn in
Turn in your Assignment4-3YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 5
Assignment 5-1: Compare heating fuel types by US counties
The US Census collects data about the fuel used to heat houses in the United States. In
this assignment, you explore where different fuel types are used throughout the country. To do
so, you download the American Community Survey data from 5-year estimates at the county
level, clean and join two data tables together, and create six choropleth maps comparing fuel
heating types by county.
Get set up
Create a new ArcGIS Pro project and map


Rename the Chapter5\Assignment5-1 folder to Assignment5-1YourName.



Open the Assignment5-1.aprx, insert a new map, and rename it US Home Heating Fuel by
County (2011-2015).



Set the spatial reference coordinate system for your map to the projected coordinate
system USA Contiguous Albers Equal Area Conic.

Download and process tabular data
Download American Community Survey data for US Counties.


From the US Census Factfinder website, Click Geographies > Geographic type County > All
Counties within United States. Add this to your selections and close the Geographies
window.



Click Topics > Housing > Physical Characteristic > Heating Fuel.



Select and download table B25040 (House Heating Fuel) for 2015 5-year estimates, and
save it to your Assignment5-1YourName folder. Note: There may be newer estimates, but
this assignment uses the 5-year estimates for 2011-2015.



In Excel, open ACS_15_5YR_B25040_with_ann.csv to clean up this data. The only attributes
that you need are a GEOID field for joining and the heating fuel type estimate fields.
Rename these with logical names (for example, TOTAL, UTIL_GAS, TANK_LP_GAS,
ELECTRICITY, OIL_ KEROSENE, COAL_COKE, WOOD, SOLAR, OTHER, NO_FUEL). Delete the
margin of error fields and any unnecessary rows. Save a comma-separated file called
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HeatingFuel.csv and import it into file geodatabase Assignment5-1.gdb as a table called
HeatingFuel and delete all originally downloaded files.
Add data to the map
 Add Assignment5-1YourName\Assignment5-1.gdb\USCounties to your map, which includes
attribute:
GEOID10 = county ANSI number


From the same location, add USStates, rename as STATES, and symbolize it using no color, a
dark gray outline width 1.5, and labeled with the state abbreviation as a white halo.



Remove overlapping labels.



Add the HeatingFuel table.

Join data and add fields
 Clean as necessary and join the HeatingFuel table to USCounties. Export the joined
features/table as CountiesHeatingFuel in Assignment5-1.gdb.


Create new fields called GAS (that adds fields UTIL_GAS and TANK_LP_GAS),
OIL_COAL_COKE (that adds fields OIL_KEROSENE and COAL_COKE), and OTHER_NO (that
adds fields OTHER and NO_FUEL).

Symbolize your map
 Use the Light Gray Canvas basemap.


Zoom to the contiguous lower 48 states, and create a spatial bookmark for this zoom.



Add the exported CountiesHeatingFuel layer six times and symbolize counties using each
heating type normalized using TOTAL for the normalization field..



Use graduated colors with quantile classifications, 4 breaks, with labels shown as
percentages with 1, 2, or 3 decimal places, depending on the data (some layers have
percentage values so low they must be 3 decimal places). NOTE: the focus of this
assignment is data joins and exploration of data and scientific so quantile classifications are
a good choice.



Use the following color schemes for heating fuel types:


blue-purple (4 classes) for GAS (all types)



blues (4 classes) for ELECTRICITY
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grays (4 classes) for OIL_COAL_COKE



reds (4 classes) for WOOD



yellow-orange-brown (4 classes) for SOLAR



greens(4 classes) for OTHER_NO



Rename each layer according to the fuel type.



Save the project with all layers on.

What to turn in
Turn in your Assignment5-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 5-2: Solar roof housing study
Government officials or businesses focused on expanding alternative housing fuel types
such as solar roofs could use GIS to determine areas within a city that are good candidates for
solar roofs. Data such as roof sizes, zoning, home values, age of home owners, or home owner
income might be criteria for determining where to best market and install solar roofs. Data for
such a study comes from local government open portal sites and US federal government sites.
In this assignment, you will download data from the City of Phoenix, Arizona, one of the
top five US cities with the highest number of solar heated homes. You will also download US
Census home value data by block group for Maricopa County Arizona.
Get set up


Rename the Chapter5\Assignment5-2 folder as Assignment5-2YourName, and open
Assignment5-2.aprx. Insert a new map, and rename it Solar roof housing study, Phoenix,
Arizona.



Find and set the spatial reference for your map to the State Plane coordinate system for
Maricopa County, Arizona.



Change the display units to Feet.

Download tabular data
Download the table of median housing values by census block group for Maricopa
County, Arizona.


From the US Census American Factfinder website, Click Geographies > Geographic type
Block Group > Arizona > Maricopa > All Block Groups within Maricopa County, Arizona, and
add this to your selections. Close the Geographies window.



Click Topics > Housing > Financial Characteristic > Value of Home.



Select and download table B25077 Median Value (Dollars) for 2015 5-year estimates, and
save it to your Assignment5-2YourName folder.



In Excel, open ACS_15_5YR_ B25077_with_ann.csv to clean up this data. The only attributes
that you need are a geoid field for joining and median value. Save and import the table into
the file geodatabase Assignment5-2.gdb as a table called MEDIANVALUE.
Download 2010 TIGER shapefiles for Maricopa County, Arizona.
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Census block groups



County subdivisions



Water features (area hydrology)
Download property parcels and parks from Phoenix Open Data.



From the open data website for the City of Phoenix, http://mapsphoenix.opendata.arcgis.com/, search for and download City Parcels and Park Boundary
shapefiles

Process data
 Import and process table and vector features Import all downloaded TIGER features, the
table for median home values, City Parcels, and Park Boundary files into Assignment5-2.gdb.
Rename the features logically and delete all original files.


In Excel, clean as necessary and join the MEDIANVALUE table to the block groups polygons.



Export the layer as a feature class in your file geodatabase called BG_MedianValue (no
spaces!) and add it to your map. Remove the original block groups and table.



Delete all original downloaded files.

Symbolize your map
 Rename all layers appropriately.


Create a choropleth map of block groups by median home value. Use classes “under
$100,000, $100,000-$200,000, $200,000-$300,000, and over $300,000” and color Purples (4
classes).



Display City Parcels as no color fill and a light gray outline.



Display county subdivisions as no color fill, a black outline, width 2, labeled with the
subdivision name, font black, bold, size 12 pt, with a white halo mask.



Display water features as blue and parks as green.
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Create a layout , figure images, and report
 Create two 11 x 8.5 landscape layouts and export each as the following figures:


Figure 1.JPG: An image that is zoomed to Phoenix and includes block groups with median
values, water features, parks, and a legend. Do not include city parcels. Create a bookmark
of this zoom called City of Phoenix.



Figure 2.JPG: An image a scale of 1:15,000, zoom to a few contiguous block groups with
median housing value is in the range of $100,000 - $200,000 or $200,000 to $300,000.
Create a figure image including the city parcels for this block group. Create a bookmark of
this zoom called Candidate Parcels.



Create a Microsoft Word document called Assignment5-1YourName.docx, that includes
your images and a very brief description of the overall city’s housing values (figure 1) and a
very brief description of the parcels (for example, how many parcels, general size (figure 2).

What to turn in
Turn in your Assignment5-2YourName folder for grading, according to instructions
provided by your instructor.

43

Chapter 6
Assignment 6-1: Build a study area for a rapidly growing Texas metropolitan area
Five of the fastest growing cities in the United States are in the state of Texas. Austin
Texas, and its surrounding area have consistently topped the list for population growth.
Georgetown, Texas, (part of the Austin-Round Rock metro area) saw a recent population rise of
7.8 percent in one year, making Georgetown the nation’s fastest growing city with a population
of 50,000 or more. This metro area is also home to Pflugerville, the nation’s recent 11th fastestgrowing large city.
In this assignment, you will build a study area for three counties in this rapidly growing
region. You will create new feature classes for an urban area study using point, line, and
polygon layers downloaded from the US Census website.
Get set up
Rename the Chapter6\Assignment6-1 folder as Assignment6-1YourName, and open
Assignment6-1.aprx. The map has the following data downloaded from the US Census 2010:


AustinMetroCities—point features of Travis and Williamson County, Texas, cities.



HaysCities—point features of Hays County, Texas, cities.



HaysStreets—line features of Hays County, Texas, County streets.



TravisStreets—line features of Travis County, Texas, streets.



WilliamsonStreets—line features of Williamson County, Texas, streets.



HaysWater—polygon features for Hays County, Texas, water.



TravisWater—polygon features for Travis County, Texas, water.



WillamsonWater—polygon features for Williamson County, Texas, water.



UrbanAreas—polygon features urban areas.



TexasCounties—polygon features of all Texas counties.

Requirements
Use Select By Location, Append, Merge, and Clip to create the following study area
features in your Assignment6-1 file geodatabase. Remove the original and any interim layers or
feature classes from the map and file geodatabase when you are finished.
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AustinMetroCounties—a feature class of Hays, Travis, and Williamson, Texas, counties only,
labeled with the county name.



AustinMetroCities—a feature class of Hays County cities appended to the original feature
class.



AustinMetroUrbanAreas—a new feature class of urban areas polygons clipped to Hays,
Travis, and Williamson counties only.



AustinMetroUrbanAreaCities—a point feature class of appended AustinMetroCities that
are completely within AustinMetroUrbanAreas, labeled with the city name.



AustinMetroUrbanAreasStreets—a feature class of the three county streets merged and
then clipped to AustinMetroUrbanAreas.



AustinMetroUrbanAreasWater—a feature class of the three county water features merged
and then clipped to AustinMetroUrbanAreas.
Create a field called Pop_Change, and calculate the population change (actual

population, not percent change) for cities from years 2000 to 2010. Show the cities using
graduated points based on the population changes.
Create a report
Create a Microsoft Word document called Assignment6-1YourName.docx. Use your
attribute table and geoprocessing tools to answer the following questions. Insert your map and
legend as an image below your answers:
1. What city had the largest population increase between 2000 and 2010?
2. What city had the largest population decrease between 2000 and 2010?
3. What are the cities and their population changes within five miles of Austin?
4. What are the cities and their population changes within five miles of Georgetown?
5. What are the cities and their population changes within five miles of Pflugerville?

Turn in your Assignment6-1YourName folder for grading, according to instructions provided by your
instructor.
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Assignment 6-2: Use geoprocessing tools to study neighborhoods
Government officials want to study areas of city neighborhoods that have
concentrations of health care, computer science, and engineering organizations and firms. In
this assignment, you have census blocks with neighborhood names, number of housing units,
and population. You also have block groups with data about the civilian population over the age
of 16 who are employed, total workers in health care fields, and male and female workers in
computer science and engineering fields. Using geoprocessing tools such as Dissolve and
Tabulate Intersection, you can tell officials what neighborhoods are health care or computer
and engineering industry rich.
Get set up
Rename the Chapter6\Assignment6-2 folder as Assignment6-2YourName, and open
Assignment6-2.aprx.
Insert a new map called Housing and Population Study, and add the following layers:


AustinBlocks—polygon features of Austin, Texas, census blocks
Insert a new map called Industry Study, and add the following layer:



TravisBlockGroups—polygon features of Travis County block groups, ACS estimates 20102014

Requirements
In the Housing and Population Study map, dissolve blocks to create Austin
neighborhoods. Use Name as the Dissolve Field and the Sum option for Housing10 and Pop10
to calculate the number of housing units and population per neighborhood. Save the new
features as AustinNeighborhoods in your Assignment6-2 file geodatabase. Add Austin
neighborhoods three times, one as a thick black outline, labeled with the neighborhood name,
and two with choropleth maps showing the sum of the 2010 population and housing units.
In the Industry Study map, add AustinNeighborhoods. Use the Tabulate Intersection tool
with AustinNeighborhoods for Input Zone Features. For Zone Fields, use Name, and for Input
Class Features, use TravisBlockGroups. Call the Output Table AustinNeighborhoods_Tabulate.
For Class Fields, use GeoID, and for Sum Fields, use HealthCare, Male_CompSciEng,
Female_CompSciEng, and Tot_WorkersOver16.

46

Summarize the new table using the Name field and statistics fields for workers in each
industry and the total workers over 16. Call the summary table
AustinNeighborhoods_IndustryWorkerSUM. Create fields calculating the percentage of health
care workers, male computer science or engineering workers, and female computer science or
engineering workers.
Join the summary table to AustinNeighborhoods and export as a feature class called
AustinNeighborhoodsIndustryWorkers. Add the layer three times, classified using the
percentage of each type of industry worker.
Display AustinNeighborhoods as a thick black outline, labeled using the neighborhood
names.
Create a story map
Create a story map using a template different than previous assignments (no analysis
needed, just a few observations). Show AustinNeighborhoods twice, using the sum of 2010
population and sum of housing units. Show AustinNeighborhoodsIndustryWorkers three times,
with the percentage of each type of industry worker. Share your map with the public and your
organization. Save the Story Map URL in a word document called Assignment62YourNameStoryMapURL.docx.
What to turn in
Turn in your Assignment6-2YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 6-3: Dissolve property parcels to create a zoning map
In this assignment, you will dissolve a parcel map to create a zoning map that highlights
a proposed commercial development in what is now a residential area. A company wants to
apply for a zoning variance to use the land in residential parcels with zoning code R5
(residential dwelling with five units) for a commercial purpose. The zoning department needs
the map for a public hearing on the proposal to use in a PowerPoint presentation to show these
parcels and general zoning for the neighborhood. You have parcels and can use the Dissolve
geoprocessing tool to make the map.
Get set up
Rename the Chapter6\Assignment6-3 folder as Assignment6-3YourName, and open
Assignment6-3.aprx. The map has the following data. Note that the map’s projection does not
align properly to its true geography, so no basemap is used.


Outline—polygon feature for the East Liberty neighborhood boundary.



Curbs—polyline features for the East Liberty neighborhood street curbs.



Parcels—polygon features of East Liberty property parcels in the East Liberty neighborhood
of Pittsburgh. Attributes include Zon_Code, an attribute with the following zoning code
values: A = development, C = commercial, M = industrial, R = residential, S = special; and
Tax_Area_A, Tax_Bldg_A, and Tax_Land—attributes with annual property tax values.

Requirements
Select parcels with Zon_Code = R5. These parcels could be converted for a commercial
purpose. Export these parcels, and add the parcels as a new layer renamed Proposed
Commercial Parcels, shown with red color fill and black outline.
Create an aggregate-level zoning code by adding a new field to the parcels attribute
table that has just the first character of the full zoning code. Call the new field Zone with text
data type and length 1. Using the Field Calculator on the new Zone field, use Zone =
!Zon_Code![0] for the expression. The [0] notation extracts the first character on the left of the
input field, Zon_Code.
Dissolve the parcel’s features using the Dissolve tool, using your new field (Zone) as the
dissolve field, and adding Sum statistics for the three tax fields (Tax_Land_A, Tax_Bldg_A,
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Tax_Area). Click in the Statistics Type cells to select Sum. Save the output feature class called
Zoning in your file geodatabase.
Add the new Zoning feature class to your map document using the Unique Values
option of the categories method of classification for symbolizing the Zone field. Use muted
colors with no outlines for the various Zone values, including Lilac Dust for A (Development),
Rose Quartz for C (Commercial), Gray 30% for M (Industrial), Yucca Yellow for R (Residential),
and Blue Gray Dust for S (Special). Label each zoning code with its full name.
Add the original Parcels as no color and gray outline, Curbs as medium-gray ground
features, and Outline as a hollow fill, thick black outline renamed East Liberty Neighborhood.
Create an 8.5 x 11 layout including a title, legend, map scale, and north arrow. Export
your map layout as Assignment6-3YourName.jpg.
Create a presentation
Create a PowerPoint presentation called Assignment6-3YourName.pptx that includes
the following elements:


Title slide, including your name



Slide with a table of the summed tax values for each zoning code



Slide with your map layout image

What to turn in
Turn in your Assignment6-3YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 7
Assignment 7-1: Conduct a campus storm water runoff project
Universities are often ideal sites for best-practice sustainability projects, including green
roofs, energy initiatives, water and ecological designs, recycling and waste reduction, and
innovative transportation projects. GIS analysis is a key part of such projects.
For example, a Carnegie Mellon University project addresses storm water runoff that
causes major flooding at the university. The project will install four concrete, waterproof
sectioned tanks—80 feet long, 16 feet wide, and 10 feet high—under one of CMU’s “mall”
areas between the College of Fine Arts lawn and Hamerschlag Hall. The installation will help
mitigate flooding during storms by collecting runoff from the downspouts and catch basins of
buildings along the mall. The underground tanks will collect runoff that can be reused for the
campus chilled water cooling system.
Trees, most effective at reducing runoff from smaller storms, also reduce storm water
runoff by capturing and storing rainfall in the canopy and releasing water into the atmosphere.
Your task in this assignment is to prepare GIS layers for facility planners by digitizing
polygons for the green spaces and points for the trees in this mall.
Get set up
Rename the Chapter7\Assignment7-1 folder as Assignment7-1YourName, and open
Assignment7-1.aprx. The project map has buildings surrounding the mall study.
In the Catalog pane, create two new feature classes in Assignment7-1.gdb, a polygon
feature class called Greenspaces, and a point feature class called Trees. Assign projection
WGS_1984_Web_Mercator_Auxiliary_Sphere to both feature classes.
Add the following layers:


Greenspaces—new polygon feature class used to digitize campus green spaces.



Trees—new point feature class used to digitize campus trees.



WalkwaysCAD.dwg—the polyline layer of the CAD drawing of CMU sidewalks and pathways.
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Spatially adjust features
 Export the polylines of the WalkwaysCAD drawing to Assignment7-1.gdb as Walkways.


Move and rotate to spatially adjust Walkways to match the walkway paths on the
university’s campus in the World Imagery map.

Digitize polygon features
 Using Walkways as a guide, digitize the green spaces on CMU’s main campus in the
Greenspaces feature class, as shown.



In the Greenspaces attribute table, change the properties of the field Shape_Area to display
zero decimal places and “thousands separators.” Label the green space polygons using
Shape_Area.
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Digitize point features
 Using the base of the tree trunks in the previous aerial image, digitize trees on this mall.

Create and export a layout
 Create a landscape layout for the study, including a title, map scale, north arrow, and
legend. Include your name as the author and the current date.


Click File > Export Map, and save your map layout as Assignment7-1YourName.jpg with 150
dpi resolution.
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Assignment 7-2: Digitize police beats
Community-oriented police officers are responsible for preventing crime and solving
underlying community problems related to crime. Among other activities, these officers walk
specific geographic areas, or “beats,” which are small networks of streets in specified areas.
Often the beats are designed in cooperation with campus police who help set policing priorities.
Beats change as problems are solved and priorities change. Therefore, having the capability to
digitize and modify police beats is a good idea. In this assignment, you will digitize two new
polyline police beats for the City of Pittsburgh Bureau of Police district near the Carnegie
Mellon University (CMU) campus based on street centerlines that make up these beats.
Get set up


Rename the Chapter7\Assignment7-2 folder as Assignment7-2YourName and open
Assignment7-2.aprx. The project map, Campus Police Beats, has streets surrounding the
university and a World Topographic Map.



In the Catalog pane, create a new polyline feature class in Assignment7-2.gdb called
PoliceBeats and assign the feature class the coordinate,
WGS_1984_Web_Mercator_Auxiliary_Sphere. In the attribute table, create a new text field
called BeatNumber, length 10.

Digitize beats
Add PoliceBeats and digitize line segments for the police beats using the guidelines as
shown in the next two tables to identify the streets in each police beat. Populate the fields as
Beat1 and Beat2 for each line segment making up each beat.
Hints: Open the attribute table for Streets. Move the table so that you can see both the
table and the streets on the map. Sort the table by field Fullname, and make multiple selections
for a given beat in the table by simultaneously holding down the Ctrl key and clicking rows
corresponding to the beat’s street segments. The streets layer is a TIGER file map with TIGER
style address number data, so look for street number ranges in the following fields: Fullname,
LFROMADD, LTOADD, RFROMADD, and RTOADD. With all streets for a beat selected, digitize
lines for streets.
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Using Unique Values, show the beats with line widths 1.5 and bright, distinctive colors
(Mars Red and Ultra Blue).



Turn the streets layer off.
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Create and export a layout
Create a layout including a legend with a title, zoomed to the police beats, and a scale
bar in feet. Include your name as the author and the current date.
Click File > Export Map and save your map layout as Assignment7-2YourName.jpg with
150 dpi resolution.
What to turn in
Turn in your Assignment7-2YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 8
Assignment 8-1: Geocode grocery stores in Allegheny County
In this assignment, you will geocode grocery stores in Allegheny County first by ZIP Code
and then by street address. As you might expect, you’ll get a high match rate for ZIP Codes but
low granularity of spatial location. For streets, the opposite will occur.
Get set up
Rename the Chapter8\Assignment8-1 folder as Assignment8-1YourName, and open
Assignment8-1.aprx. The project map has the following data:


GroceryStores table with attributes Size (Small, Medium, and Large), a classification of store
size; Address, City, and ZIP Code



AllCoZIP, Allegheny County ZIP Codes with attribute ZIP = ZIP Code



Municipalities, Allegheny County municipalities



Streets, Allegheny County TIGER streets

Build Locators
Create two locators stored in your Assignment8-1 folder. Use default settings for
parameters.


AlleghenyCountyZIPCodesLocator using AllCoZIP as the reference data.



AlleghenyCountyStreetsLocator, using Streets as the reference data.

Geocode grocery stores
 Geocode grocery stores to ZIP Codes to create GroceryStores_ZIPCodes.


Geocode grocery stores to streets to create GroceryStores_Streets.

Symbolize results
Include a map layout with a choropleth map using the count of grocery stores by ZIP
Code and street address-matched grocery store points symbolized using size. Display
Municipalities prominently but with no color fill. Do not display streets.
Present results
Create a word document, Assignment8-1YourName, including a title and name. Report
match statistics in the document as follows for ZIP Code and street matching:
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Number matched (percentage matched)



Number tied (percentage tied)



Number unmatched (percentage unmatched)
Include a map layout with your municipal layer, choropleth map by ZIP Code, and street-

address-matched grocery store points symbolized using size. Do not display streets.
What to turn in
Turn in your Assignment8-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 8-2: Reverse geocode a random sample of points representing stops for
Meals on Wheels kitchen siting
Reverse geocoding takes points on a map and finds their nearest street address points
using a street map and locator. This workflow is valuable for applications involving estimating
demand for goods or services. In this assignment, demand refers to a facility location
problem—locating new kitchens for Meals on Wheels. This home-delivery service provides hot
meals each day to help elderly persons who want to live independently in their homes instead
of moving to an assisted living facility.
The challenge of locating new kitchens requires, as input, a point layer of addresses for
delivery. Of course, the current set of customer addresses does not represent future demand
patterns over the life of a kitchen facility. Moreover, opening a new kitchen in an underserved
area will create new demand. A better first step is to take a random sample of locations relative
to the distribution of elderly persons, using the Create Random Points tool. Pittsburgh has
42,151 persons 65 and older, and an estimated 8.3 percent of them would like to use the Meals
on Wheels program. So you’ll create random points per census tract using 8.3 percent of the
elderly population by tract. Then you’ll use the Reverse Geocode tool to move those points to
street addresses representing stops. A Meals On Wheels algorithm is not available here, but
such an algorithm would optimally locate new kitchens relative to existing kitchens to optimally
serve the demand spatial pattern.
Get set up
Rename the Chapter8\Assignment8-2 folder to Assignment8-2YourName. Open
Assignment8-2.aprx. The project map has the following layers:


PghTracts has census tracts for Pittsburgh, and the attributes include GeoID10 and
Age_65_Up



PghStreets has TIGER streets for Pittsburgh

Create a random sample of points
 Add a new column, ElderlySample, Long data type, to PghTracts and calculate
ElderlySample as 0.083 * Age_65_Up.


Sort ElderlySample descending in the table.
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Use the Create Random Points tool to create the ClientPoints layer using PghTracts as the
constraining feature class and ElderlySample as the Number of Points field. Allow a
minimum distance of 100 feet between points.

Reverse geocode points
 Create a dual-range locator for PghStreets called PghStreets_Locator in the Assignment8-1
folder. Leave the geocoding parameters at their default values.


Use the Reverse Geocode tool with ClientPoints as input, PghStreets_Locator as the input
locator, and ClientAddresses as output. Leave the Output Address Type as Address, and the
search distance at 100 meters.

Present results
Create a word document, Assignment8-2YourName.docx, including a title and your
name. Include two JPEG images of a map with streets, tracts, and ClientAddresses, one showing
all of Pittsburgh and the second zoomed into tract 42003141100, which has the greatest
number of persons 65 and older. Include the sample size, the number of random samples with
addresses.
What to turn in
Turn in your Assignment8-2YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 8-3: Conduct a sensitivity analysis of parameters for geocoding
There are no guidelines for selecting the match parameters (minimum match score,
minimum candidate score, and spelling sensitivity) that tune the ArcGIS Pro Geocoding tool. So,
in this assignment you will test the sensitivity of geocoding accuracy to variations in those
parameters and in the process, make your own rough guidelines.
The data that you’ll geocode, grocery stores, is good for many purposes, including
identifying “food deserts” for poor populations in urban areas who are not close enough to a
grocery store for ease of access.
First, you’ll geocode using default parameters (85, 75, and 80 for minimum match score,
minimum candidate score, and spelling sensitivity respectively). In addition, you’ll use the
strictest possible parameter values and the most lax (or lenient) values. The larger the
parameter values (which all range between 0 and 100), the stricter the fuzzy matching rules;
and the smaller the parameter values, the more lax the rules. So, the parameters you’ll try (100,
100, 100) are the strictest/most conservative possible, and (0, 0, 0) the most lax/liberal
possible.
Get set up
Rename the Chapter8\Assignment8-3 folder to Assignment8-2YourName. Open
Assignment8-3.aprx. Its map has the following layers:


GroceryStores table with attributes Size (Small, Medium, and Large), a classification of store
size; Address, City, and ZIP Code



Municipalities, Allegheny County municipalities



Streets, Allegheny County TIGER streets

Geocode grocery stores
 Create the StreetsLocator locator in your Assignment8-3 folder using Streets as the
reference data.


Geocode GroceryStores with default locator parameters to create GroceryStores_Default.
Symbolize with a size 9 circular point symbol.



Use the Catalog pane, right-click your locator, and expand Locators and click Locator
Properties > Geocoding options to change parameters and geocode.
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GroceryStores_Strictest: minimum match score = 100, minimum candidate score
= 100, spelling sensitivity = 100. Geocode grocery stores with these parameter
settings. Symbolize the resulting grocery store with a size 6-point symbol.



GroceryStores_MostLax: minimum match score = 0, minimum candidate score =
0, spelling sensitivity = 0. Geocode grocery stores with these parameter settings.
Symbolize the resulting grocery store with a size 12-point marker and contrasting
color.



Arrange geocoding results top-down with strictest, then default, and lax in the Contents
pane.

Analyze results
Open Assignment8-3.docx from Chapter8\Assignment8-3, which has the three tables
that you need to fill out (and are also listed below for reference). ). Save the Word document as
Assignment8-3YourName.docx and fill out the following table with match statistics:

Zoom into Pittsburgh and use Pittsburgh grocery stores only for the sensitivity analysis
(Grocery stores that fall inside the Pittsburgh boundary). Hint: Don’t use the City attribute in
your geocoded map layers to decide what grocery stores are in Pittsburgh. Use the map instead,
because sometimes stores list their city as Pittsburgh while being near to but not actually in
Pittsburgh.
Using your mapped points, first turn on the Strictest and Default point layers. Select
Default points on the map that are not matched in the Strictest layer (those matches were
added because of the more lax parameters of the default settings). Click added points one at a
time, and copy and paste street names to table 2.
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The Good, Bad, (don’t know) Match, and Reason column explains geocoding behavior in
transitioning from the strictest to the default locator. Start by typing Good, Bad, or ???in that
column. Use your judgment for Good, Bad, or ???, and then type a reason.
As a criterion, suppose that the level of accuracy that we need is to have a matched
point house number to not be different by more than 25 from the raw input address’s street
number.

Turn off the Strictest layer and turn on the Most Lax layer and do the same analysis for
the Default and Most Lax layers. Hint: zoom far in to find all points added by the most lax
geocoding.
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For the three locators that you tried, make a recommendation in your Microsoft Word
document on which locator to use and why. If you were to try additional locator parameter
settings, which ones would you try next?
What to turn in
Turn in your Assignment8-3YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 9
Assignment 9-1: Study California cities affected by earthquakes
Using buffers in this assignment, you’ll determine cities and populations possibly affected by
California earthquakes that occurred in the 1980s and early 1990s.
Get set up
Rename the Chapter9\Assignment9-1 folder to Assignment9-1YourName. Open Assignment91.aprx. The needed map layers (California Earthquakes, California Cities, and California
Counties) are already included in the map that opens.
The following are definitions of attributes that you’ll use from the CaliforniaEarthquakes
layer. Selected from the original dataset available were earthquakes from 1980 and newer and
which had damages reported.


Deaths = number of deaths attributed to an earthquake



Damage = property damages ($) attributed to an earthquake



MMI = Modified Mercalli Intensity Scale has codes corresponding to increasing damage.
Values of 7 to 12 correspond to damage of poorly constructed buildings through total
destruction. The data has values from 7 through 9.

The CaliforniaCities layer has cities with at least 1,000 population and includes attributes. Name
= city name and POP_2000 = 2000 population.
Requirements
Use buffers to learn the number of cities and the total population within 10 miles of
earthquakes for the given data. Write a short report, Assignment9-1YourName.docx, with a
layout of your finished map and statistics on the number of cities and total population within
buffers.
What to turn in
Turn in your Assignment9-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 9-2: Analyze geographic access to Federally Qualified Health Centers
Federally Qualified Health Centers (FQHCs) provide subsidized, health services to
underserved poor populations. There are 17 FQHCs in Pittsburgh, well-located in poverty areas.
In this assignment, you’ll compare two methods of estimating the number of persons who have
good geographic access to FQHCs: buffers versus service areas (travel time polygons) computed
using Network Analysis.
Suppose that a travel time of three minutes or less by car to an FQHC is considered good
geographic access. Given a street network, it’s easy to estimate three-minute travel time
polygons for the FQHCs.
For buffers, you need a buffer radius that roughly approximates three-minute maximum
travel times. Suppose that non-rush-hour urban traffic—including stops, turns, and so on—
averages 15 miles per hour overall. Using 15 miles per hour (or 15/60 miles per minute), three
minutes corresponds to 1-mile radius buffer for straight-line travel from a residence on the
buffer’s perimeter to an FQHC. Of course, travel distance for residences on the buffer’s
perimeter where turns are necessary to get to a FQHC would be longer than 1 mile.
Get set up
Rename the Chapter9\Assignment9-2 folder to Assignment9-2YourName. Open Assignment92.aprx.The needed map layers are already included in the map that opens:


PittsburghBlockCenterPoints, center points for block polygons with POP10 = 2010
population attribute



FQHC, FQHC points with Name = name of FQHC



PittsburghStreets_ND, street network created from TIGER files using average travel times by
street type (as in tutorial 9-5)



Pittsburgh, outline of city

Requirements
Create 1-mile, dissolved buffers for the 17 FQHCs in Pittsburgh and create dissolved 3
minute service-area polygons for the same FQHCs.
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Assume that any block center point that is inside a buffer or service area has good access
to one or more FQHCs (even though parts of some blocks will be outside the buffers or service
areas).
Determine the population and percent total population that has good geographic access
to FQHCs based on buffers and service areas. Create a Microsoft Word document called
Assignment9-2YourName.docx that includes a layout of your finished map with FQHCs, buffers,
travel-time polygons, streets, and other layers turned on, and includes the statistics requested
above. How good or bad are the buffer estimates compared to the superior service-area
estimates?
What to turn in
Turn in your Assignment9-2YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 9-3: Analyze visits to the Phillips public pool in Pittsburgh
In this assignment, you will estimate a gravity model for visits of youths to Phillips pool
in Pittsburgh using service areas. The question addressed is whether the average number of
visits made to Phillips pool in a season declines with travel time to the pool.
Get set up
Rename the Chapter9\Assignment9-3 folder to Assignment9-3YourName. Open
Assignment9-3.aprx.The needed map layers, including the PittsburghStreets_ND network
dataset, are already included in the map that opens.
The PhillipsVisits layer has a random sample of visits to the Phillips pool. Attributes
include:


Pool = name of the pool that the pool tag owner stated that he/she intended to use



NOPersons = number of persons in the party or family for a visit



Age = age of the person in the party included in the random sample



Visits = number of visits that the person included in the random sample actually made to
the pool during the summer studied
The following definition query has been added to PhillipsVisits so that you analyze only

youths:
AGE is Greater Than or Equal to 5 And AGE is Less Than or
Equal to 17
Symbolize PhillipsVisits with size-graduated point markers using the Visits attribute.
From the map alone, it’s difficult to discern whether average number of visits declines with
distance or travel time from the pool.
Requirements
Select Phillips pool in the Pools layer to restrict the service areas to that pool only.
Create dissolved multiple-ring service areas for the Phillips pool using impedances of minutes of
travel time to the pool. Use the following ranges of travel-time distances for service area rings:
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0 to 1, 1 to 2, 2 to 3, 3 to 5, and 5 to 9. Symbolize the service areas colors from the color
spectrum (for example, green through red).
Spatially join PhillipsVisits to Polygons of the service area, and calculate the mean for
VISITS for each buffer ring. Hints: Call the new layer PhillipsServiceAreaVisits. When setting up
geoprocessing for the spatial join, select Visits in the Field Map of Join Features panel and use
Mean for the Merge Rule.
Create a short Microsoft Word document, Assignment9-3YourName.docx, with a table
that includes Name, Frequency (Join_Count), and Mean Visits (visits from the Spatial Join
attribute table) and a map layout zoomed into the service area Polygons layer. Comment on the
pattern in the statistics.
What to turn in
Turn in your Assignment9-3YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 9-4: Locate new farmers markets in Washington, DC
Urban farmers markets supply locally grown produce for communities, and are
especially important for poor neighborhoods that tend not to have grocery stores. This
assignment uses data for Washington, DC, on its farmers markets plus block group data on
populations with incomes below the poverty line. The objective is to select the best five out of
15 potential sites for additional farmers markets, keeping the existing markets and adding five
more that maximize the number of poor persons as potential customers.
Get set up
Rename the Chapter9\Assignment9-4 folder to Assignment9-4YourName. Open
Assignment9-4.aprx.The needed map layers, including the DCStreets_ND network dataset
(street network dataset constructed from TIGER street centerlines), are already included in the
map that opens. Other layers are


FarrmersMarkets = 22 existing farmers’ markets



XYNewLocs = 15 potential new sites for farmers’ markets



DCPovBlkGrpCntrd = 2010 block group centroids with five-year 2013 ACS data on poverty


Pop13 = population for which poverty status is known (577,244 total)



PopPov13 = population below poverty line (109,200 total)

Requirements
Create a new Location-Allocation model to maximize attendance. Add all 22 farmers
markets as required and the 15 potential new locations as Candidate locations. Use
DCPovBlkGrpCntrd for demand points with PopPov13 as the field for Weight. Use 27 for the
facilities to choose (22 required and 5 of the 15 candidates).
We do not have a gravity model calibrated with customer data and so you must exercise
judgment for the fall-off of farmer market use with travel time, along with a sensitivity analysis.
Use Linear for the Impedance Transformation with three alternative impedance cutoffs for
three runs of the model: 15, 20, and 25 minutes to see if the solution of chosen potential sites
is robust (does not vary with variation in cutoffs). Hint: Make your ArcGIS Pro window wide
enough so that you can see the Cutoff field under Travel settings. Type a cutoff of 15 for the first
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model run, and so on. Also, zoom in to see lines connecting facilities and block groups served
after running each model. Recall that for a cutoff that the model allocates 100 percent of
population as users at 0 minutes and then linearly decreases users to 0 percent at the cutoff.
Here we’re guessing a linear decline with 15-minutes cutoff as conservative, 20 minutes as
expected, and 25 minutes as optimistic. Run the model with each of these times. Create and fill
out a table in Microsoft Word similar to the one below where you enter the names of five
chosen sites for each cutoff and highlight any differences. Also, include the sum of
DemandWeight from the Facilities table for each cutoff, which is the estimate of total users.

Create a Word document, Assignment9-4YourName.docx, with a title, your name, the
above table, and a layout of your map showing the 25-minute cutoff solution, including lines
from block group centroids to farmers markets sites. Comment on the sensitivity of the three
solutions.
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What to turn in
Turn in your Assignment9-4YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 9-5: Carry out a cluster analysis of tornadoes
A tornado is a rotating column of air, a condensation funnel that is generally visible,
touching the ground, and extending up to a cumulonimbus cloud. While a tornado can appear
almost anywhere, the greatest number in the United States occur in the “Tornado Alley,” an
area including Texas, Arkansas, Oklahoma, Nebraska, South Dakota, and Iowa. In this
assignment, you will explore tornadoes from the year 2000 through 2008 that had at least one
injury or fatality each. You’ll use k-means clustering, combining several measures of impact to
identify areas with the most fatalities, injuries, and damages and answer the question—are
they inside or outside of Tornado Alley?
Get set up
Rename the Chapter9\Assignment9-5 folder to Assignment9-5YourName. Open
Assignment9-5.aprx. Following are definitions of attributes that you’ll use from the tornadoes
feature class:


F_SCALE = Fujita Tornado Damage Scale:


0 = light damage (winds , 73 MPH, shallow trees blown over)



1 = moderate damage (73-112 MPH, mobile homes pushed off foundations)



2 = considerable damage (113-157 MPH, mobile homes demolished)



3 = severe damage (158 – 206 MPH, most trees in forest uprooted)



4 = devastating damage (207-260 MPH, well-constructed houses leveled)



5 = incredible damage (261-318 MPH, automobiles fly through the air for over
100 meters, trees debarked) 1



AREA = area hit by tornado (tenths of miles squared)



DAMAGE = property damage in $ millions



INJ = number of injuries



FATAL = number of fatalities

1

http://www.spc.noaa.gov/faq/tornado/f-scale.html
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The “distances” of 1 between values of F_SCALE category numbers (0, 1, 2, 3, 4, 5)
clearly do not represent a measure of relative cost or impact of tornadoes. You’d expect the
distance between categories to increase as tornadoes become more damaging. As an estimate,
you’ll use the square of F_SCALE (F_SCALE_Sqd = 0, 1, 4, 9, 16, 25) for clustering. Note that
while you can modify the weight or distance between values in an attribute such as F_SCALE, all
numerical input attributes are equally weighted among themselves because the Multivariate
Clustering tool automatically standardizes all numerical input attributes. Therefore, even
though you might determine that injuries are twice as important as damages and that fatalities
are three times as important as damages, multivariate clustering gives all three of these
attributes the same weight for clustering purposes.
Run k-means clustering
Use the following with the Multivariate Clustering tool:


F_SCALE_Sqd, AREA, DAMAGE, INJ, and FATAL as inputs



Seeds from the field, Seed (which has 5 rows with Seed = 1 and therefore leads to 5
clusters)

Interpret and symbolize grouping results
Calculate means of input attributes by cluster and create meaningful labels for each of
the groups in a table for the means and on your map. Show three categories for each cluster
and attribute: High, Medium, and Low. For example, for clusters, assign High Impact, Medium
Impact, and Low Impact; for FATAL assign High Fatalities, Medium Fatalities, and Low Fatalities;
and so forth. Change colors to show impact (for example, with red being high impact, orange
being medium, and yellow being low). Make the symbol sizes large to small by category of
impact.
Present results
On your map, select Texas, Arkansas, Oklahoma, Nebraska, South Dakota, and Iowa to
represent Tornado Alley. How do your results for Tornado Alley compare to the rest of the
United States using impact as the criterion? Make a layout with your map and legend, and
export it to your assignment folder as Tornadoes.jpg. Create a short report in Microsoft Word,
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Assignment9-5YourName.docx, including your table of means and labels as Table 1 and the
layout as Figure 1. Describe how you got the clusters (in tornado attribute space). Discuss your
map in terms of Tornado Alley.
What to turn in
Turn in your Assignment9-5YourName folder for grading, according to instructions
provided by your instructor.
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End author edits

Chapter 10
Assignment 10-1: Create raster maps for the Pittsburgh Almono development area
The Almono Limited Partnership, made up of four Pittsburgh grant-making foundations,
bought the 178-acre brownfield site of Pittsburgh’s former LTV Corporation integrated steel
mill, which is in sight of downtown Pittsburgh on the north shore of the Monongahela River,
now known as “Hazelwood Green”(see https://www.hazelwoodgreen.com/). The partners
envision a multiple-use, sustainable development for the site. Your assignment is to build some
raster datasets for an Almono GIS that has the purpose of evaluating the impact of the
development on neighboring areas over time.
Pittsburgh neighborhoods adjacent to Almono and north of the river—Glen Hazel,
Greenfield, Hazelwood, and Squirrel Hill South—make up the study area. The river forms a
barrier to interactions with neighborhoods to the south. Your task is to create a hillshade map,
elevation contours, and a population density raster map for this area, part of what you can
imagine would become a larger GIS with many other feature classes and raster datasets. Not all
layers that you create would necessarily be displayed at the same time. Also, the elevation
raster datasets are key to creating 3D maps. To save you some time, considerable effort has
already been done to get the inputs downloaded and into good form for processing.
Get started
Rename the Chapter10\Assignment10-1 folder to Assignment10-1YourName. Open
Assignment10-1.aprx.. The project’s file geodatatbase, Assignment10-1.gdb, includes the
following starting feature classes and raster dataset:


Neighborhoods, polygon features for neighborhoods in Pittsburgh.



AlmonoSite, boundary of the Almono development site.



AlmonoAreaBlocks, block centroids in a 2,000-foot buffer of the study region. You’ll be
estimating a population density surface with this data, so the additional data outside of the
study area is needed to better estimate density at the boundaries of the region. Population
= 2014 estimated population.
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HazelNED, 1/9 arc second (30-foot resolution) elevation data (in meters) for an area larger
than but including the study region. The raster dataset is in latitude/longitude coordinates.

Save all new raster datasets that you create in Assignment10-1.gdb.
Create a study region
 Create a study-area feature class called AlmonoStudyArea, consisting of the Glen Hazel,
Greenfield, Hazelwood, and Squirrel Hill South neighborhoods. Retain neighborhood
boundaries of the four neighborhoods. Symbolize the corresponding map layer with hollow
fill. Label with neighborhood name and a halo.


Make the study region’s extent be the full extent for the data frame. Hint: Search for
“custom full extent” in ArcGIS Pro Help.

Create a hillshade
 For geoprocessing environments, select AlmonoStudyArea as the mask, and set cell size
“Same as layer HazelNED.” Note: ArcGIS Pro processes raster maps in their native
coordinates (latitude/longitude for HazelNED), so you need to use HazelNED’s cell size to
create a hillshade. The cell size is a very small number in decimal degrees.


Extract AlmonoNED from HazelNED with the extent of AlmonoStudyArea. In the Extract by
Mask geoprocessing pane, click Environments and then the Projection button to the right of
Output Coordinate System. Select the State Plane NAD 1983 (US Feet) projection for
Pennsylvania South, and then click Parameters.



Create a hillshade map from AlmonoNED called AlmonoHillshade using default parameter
values. Symbolize AlmonoHillshade with Classified, Standard Deviations, one-fourth
standard deviation, and a black-to-white color scheme.



Use the Imagery basemap, make it about 20% transparent, and place AlmonoHillshade
below it to enhance Imagery’s appearance.

Create elevation contours
 Create elevation contours called AlmonoElevationContours with a base of 0 and a 20-foot
interval from AlmonoNED. Optional: Label with Contour (use some advanced positioning to
get the labels to be on and follow the contours and to have a halo). Warning: it takes a lot
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of computer resources for ArcGIS Pro to do the labeling, so you might have to wait for
labeling to finish. If your computer cannot handle labeling contours, turn labeling off.
Create a population density surface
 The next raster you create uses the distance units of the data frame, State Plane feet, so reset the geoprocessing environment. Leave AlmonoStudyArea as the mask but set cell size to
50 (feet).


Create a kernel density map called AlmonoPopulationDensity from AlmonoAreaBlocks
using Population, a search radius of 1,500 feet, and area units of square miles. Symbolize
with Classify but otherwise as you like.

Prepare maps displaying results
Remove all layers added as inputs that are no longer needed. In the Catalog pane, copy
and paste your map and paste it twice. Name the three maps as below. Turn layers on and off
in each map as specified below.


Imagery—Imagery and AlmonoHillshade, AlmonoStudyArea, and AlmonoSite turned on
with all other layers turned off.



Elevation Contours—AlmonoElevationContours turned on and not labeled, but all other
layers turned off, including the Imagery basemap. Labeling takes a long time to draw for the
contours.



Population Density—AlmonoPopulationDensity, AlmonoStudyArea, and AlmonoSite turned
on with all other layers turned off including the Imagery basemap.

Export a JPEG image of each map (just the maps and not layouts) with names that identify
them.
What to turn in
Turn in your Assignment10-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 10‐2: Estimate heart attack fatalities outside of hospitals in Wilkinsburg by
gender
Men have a higher incidence of heart attacks than women. Unfortunately, though,
women have a higher incidence of fatal heart attacks than men, perhaps because symptoms of
heart attacks in women are less well-known than those for men. Fatal heart attacks outside of
hospitals are roughly 1.5 per thousand for men aged 35 to 74 and 2.3 per thousand for women
(50 percent higher) in the same age range. In this assignment, you will create two density map
layers—one for men and one for women—using these incidence rates for the municipality of
Wilkinsburg in Allegheny County.
Get set up
Rename the Chapter10\Assignment10-2 folder to Assignment10-2YourName. Open
Assignment10-2.aprx.


Insert a new map and name it Heart Attack Fatalities.



Save all new map layers you create to Assignment10-2.gdb.



Add the following feature classes to your map document from Assignment10-2.gdb:


AllCoBlocks—point layer for census block centroids in Allegheny County



Municipalities—polygon layer for municipalities in Allegheny County

Requirements


Select the Wilkinsburg polygon from Municipality, and export it as Wilkinsburg. Make
Wilkinsburg the full extent of your map.



Create a 1500 foot buffer of Wilkinsburg called WilkinsburgBuffer.



Extract the buffered Wilkinsburg blocks from AllCoBlocks using WilkinsburgBuffer, and save
them as WilkinsburgBlocks.



Add floating point fields to the attribute table for WilkinsburgBlocks:


FMortInc = 0.0023 × [Fem35T74] is the annual number of heart‐attack fatalities
for women aged 35 to 74.



MMortInc = 0.0015 × [Male35T74] is the annual number of heart‐attack fatalities
for men aged 35 to 74.
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Create kernel density map layers for MMortinc and FMortinc, called MaleMortality and
FemaleMortality, using Wilkinsburg as the mask, a cell size of 25, and a search radius of
1,500 feet. Give the outputs descriptive names and add them to the map.

Additional requirements


Symbolize the female mortality surface using Classified from the left panel of the Symbology
tab of Layer Properties. Use the Standard Deviation Classification method with one-fourth
standard deviation intervals. Create a layer file from this layer, and import it for male
mortality so that both layers have identical breakpoints and color ramp. Then you can easily
compare female and male incidence. Hint: To create the layer file, right-click
FemaleMortality, click Save As Layer File, and save it in your assignment folder. Then in the
Symbology pane for MaleMortality, click the Options button at the top right (four horizontal
bars), click Import, and import the layer file.



Using the Catalog pane, copy and paste your map and rename maps to create Heart Attack
Fatalities Female and Heart Attack Fatalities Male.



Create a layout with two maps, comparing both density surfaces.



Add a text note on your layout explaining what contributes to the increased densities for
females. Hint: Use the Summary Statistics Tool to get total populations and incidences for
males and females.



Export your layout as a JPEG with 150 DPI resolution and name it Wilkinsburg.jpg.

What to turn in
Turn in your Assignment10-2YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 11
Assignment 11-1: Prepare 3D building and topography features for a 3D study
3D GIS is an essential tool for managing campuses for many organizations including
universities, hospitals, office parks, shopping centers, and others who have buildings and land
parcels to manage. Having 3D campuses are important for owners and operators who need
planning and maintenance tools to serve students, customers, and shoppers using outdoor and
indoor spaces. Security, safety, staffing, networking, ADA (Americans with Disabilities Act)
compliance, and utility management are just a few reasons to use GIS to create 3D campuses.
In this assignment, you prepare a local scene for use in a 3D campus study for two of
Pittsburgh's largest academic campuses of Carnegie Mellon University and the University of
Pittsburgh.
Get set up
Rename the Chapter11\Assignment11-1 folder to Assignment11-1YourName and open
Assignment11-1.aprx. Its map has the following data in a 2D map:


Buildings3D_Pitt — polygon features of University of Pittsburgh buildings, including an
existing building height field that has already been derived from Lidar data



Buildings2D_CMU— polygon features of Carnegie Mellon University buildings, used to
create a building height field derived from Lidar data



Topo—polyline topography contour features of the campus study area



StreetCurbs—2D polyline layer of street curbs



Parks—2D polygon layer of parks

Build a TIN surface
Create a TIN surface called CAMPUS_TIN from the contours polylines using the same
coordinate system as the contours layer.
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Create 3D buildings from Lidar data
 Using LAS files found in Assignment11-1\Data\LASFiles, create a LAS dataset called
Assignment11-1_LASDataset. These are for the CMU campus buildings only. The University
of Pittsburgh's buildings already have a 3D height field.
Create DSM (digital surface model) using first return LAS points, DTM (digital terrain
model) using ground LAS points, and nDSM (normalized digital surface model). Use a cell size of
5 feet for all rasters and correct settings for each raster type (for example, Binning interpolation
for DSM and Triangulation for DTM).


Create random points for Buildings2D_CMU with 100 points and a minimum allowed
distance of 5 feet.



Apply the nDSM surface to the buildings, and use summary statistics to generate a Z value
(height) for the buildings.



Join the summary statistics to the Bldgs features and create a field called Height that is
calculated from the statistics table Z field. Remove the summary statistics join and export a
feature class called Buildings3D_CMU to your assignment's file geodatabase.



Add Buildings3D_CMU to your map, and remove Buildings2D_CMU from the Contents pane.

Create a local scene
 Convert the map to a scene and make it a local 3D scene called CampusStudy_3D using
Campus_TIN as the current surface, displaying it as a slope, simple feature using a neutral
color.


Clip the layers to the extent of the Campus_TIN layer and change the scene's coordinate
system to NAD 1983 State Plane PA South.



Remove the existing ArcGIS Online service 3D Terrain surface and all 2D layers except
StreetCurbs, Parks, and Campus_TIN.



Display the Buildings3D_CMU as 3D features using the Height field.
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Edit a building's height
 The University of Pittsburgh's Cathedral of Learning building height is incorrect in the
attribute table (250 feet). Using Lidar points, scale the building to its correct height or edit
the Buildings3D_Pitt building attribute table to correct the height to its actual height of 535
feet.
Create bookmarks
Create three bookmarks:


Pitt campus—view from Pitt's campus to CMU's campus buildings to the east



CMU campus—view from CMU's campus to Pitt's campus buildings to the west



Cathedral of Learning—3D zoomed view of one of the tallest academic buildings in the
world.

What to turn in
Turn in your Assignment11-1YourName folder for grading, according to instructions
provided by your instructor.
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Assignment 11-2: Create a realistic 3D scene for a campus study
Building footprints extruded to 3D are useful for a planning study but need details using
procedural rules and multipatches for buildings. Rules to display point features as realistic trees
make for a more interesting and useful planning project. In this assignment, you will use a
multipatch layer of the University of Pittsburgh's Cathedral of Learning, a building with many
levels and various heights. You will apply procedural rules to a few buildings on Carnegie Mellon
University's campus to give context to the site and use a procedural rule for CMU campus trees
and a thematic procedural rule to street trees. You will then create and export an animation
that could be used by campus architects and planners in a town hall meeting with citizens and
campus stakeholders.
Get set up
Rename the Chapter11\Assignment11-2 folder to Assignment11-2YourName and open
Assignment11-2.aprx. Its map has the following data in a 2D map:


CathedralOfLearning—multipatch layer of the University of Pittsburgh's Cathedral of
Learning building whose actual building and facade are seen in the image below.
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3DBldgs—polygon features of buildings footprints in the urban campus study area, including
a building height field



CarnegieMuseum— a polygon feature of a building footprint of the Carnegie Museum of
Natural History



CyertHall—a polygon feature of a building footprint of Carnegie Mellon University's Cyert
Hall academic and administration building



HamburgHall—a polygon feature of a building footprint of Carnegie Mellon University's
Hamburg Hall academic building



WarnerHall—a polygon feature of a building footprint of Carnegie Mellon University's
Warner Hall administration building



MorewoodGardens—a polygon feature of a building footprint of Carnegie Mellon
University's Morewood Gardens dormitory



StreetCurbs—polyline features of street curbs in the urban campus study area



Parks—2D polygon features of parks in the urban campus study area

Create and configure the scene
 Convert the 2D map to a 3D local scene called Urban Campus_3D.


Set the coordinate system to NAD 1983 State Plane Pennsylvania South FIPS 3702 (US Feet).



Set the map units to Foot US, and Display and Elevation units to Feet.



Set the extent to Custom extent using Bldgs3D as the layer to calculate from and clip layers
to extent.



Use a Light Gray Canvas basemap.

Configure 3D building layers
 Set the elevation properties of the CathedralOfLearning multipatches to "On the ground".


Display Bldgs3D using Max height and the Height field. Symbolize as solid features.



Change the symbology of the CarnegieMuseum layer using procedural rule "Extruded
Building Shape"; Units = Feet; EaveHeight = [Height] field; Levels = 2; RoofForm = Flat; Roof
Texture = Color; RoofColor = Gray 70%; and FacadeTexture = Limestone. Turn Show
Windows on and use WindowWidth = 10 and WindowHeight = 20.
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Change the symbology of the CyertHall layer using procedural rule "Stacked Blocks";
Representation = Thin divider; Units = Feet; TotalHeight = [Height] field; and Levels = 4.



Change the symbology of the HamburgHall layer using procedural rule "Extruded Building
Shape"; Units = Feet; EaveHeight = [Height] field; Levels = 4; RoofForm = Gable; Roof Angle
= 45; Roof Texture = Color; Roof Color = Deep Forest Green; FacadeTexture = Color and
FacadeColor = TopazSand (20% transparent). Use a FloorSeparator of 10% and
SeparatorColor = Gray 10%.



Change the symbology of the MorewoodGardens layer using procedural rule "Extruded
Building Shape"; Units = Feet; EaveHeight = [Height] field; Levels = 7; Flat Roof, Roof Texture
= Gravel; FacadeTexture = Brick; and turn Show Windows on.



Change the symbology of the WarnerHall layer using procedural rule "International
Building"; Units = Feet; BuildingType = Highrise; FloorHeightGround = 5; FloorHeightUpper =
2, and TotalHeight = Height field.

Configure 3D trees
 Add Assignment11-2.gdb\StreetTrees as Preset Thematic trees; Type = Spherical; Height =
FromType; Crown Width = Proportional; and Color = Sage Dust.


Add Assignment11-2.gdb\CMUTrees as Preset Realistic trees; Type = Genus; Height =
FromType; and Crown Width = Proportional.

Create bookmarks
Create five bookmarks called Frame1, Frame2, Frame3, Frame4, and Frame5. Start with
a view from the University of Pittsburgh's campus showing the Cathedral of Learning looking
toward CMU's campus. Zoom into Forbes Avenue, and create the remaining four bookmarks
along this street, ending at a bird’s-eye view of CMU's Warner Hall, including a view of CMU's
campus.
Create an animation
Turn the CMU Trees off. Using the bookmarks as initial keyframes, create a 20-second
animation. Adjust the keyframes and cameras to make an interesting animation. Export the
animation as a Draft MP4 video called Assignment11-2YourName.mp4.
What to turn in
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Turn in your Assignment11-2YourName folder for grading, according to instructions
provided by your instructor.
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Chapter 12
Assignment 12-1: Create tasks to publish a choropleth map for the Graffiti Dashboard
operation view
In this assignment, you’ll revise and extend the Prepare Graffiti Data for ArcGIS Online
task item of tutorial 12-1 to add a choropleth map with the number of graffiti calls by
neighborhood while keeping the original graffiti call point map layer also in the map. One of the
tasks is to run the Graffiti Data Import model, and you’ll have to extend this model to create the
choropleth map. The choropleth map provides the “big picture” of graffiti spatial patterns by
neighborhood, and the original graffiti points provide the details. In Assignment12-2 you’ll build
an operation view using Operations Dashboard for ArcGIS® that includes the new map with
choropleth map layer added, and new or modified widgets.
Get set up
Rename the Chapter12\Assignment12-1 folder to Assignment12-1YourName. Open
Assignment12-1.aprx The map has the Graffiti point layer plus a new choropleth map,
GraffitiByNeighborhood.
Open the Catalog pane to see that you have the completed Graffiti Data Import model
from tutorial 12-1 and the completed Prepare Graffiti Data for ArcGIS Online task item from
tutorial 12-2. You’ll edit the model and task item to add more processes and tasks. The map
already has the choropleth map for graffiti calls by neighborhood, but you need a model to
create that map at the start of each new week.
Extend the Graffiti Data Import model
To make the choropleth map in the Graffiti Data Import model, you need to make a
spatial join of Neighborhoods and Graffiti to create a new polygon feature class,
GraffitiByNeighborhood. The join automatically produces an attribute called Join_Count that
has the count of graffiti calls by neighborhood. Add and configure the Spatial Join tool to the
bottom of the model.
Now you need to add a second Apply Symbology From Layer tool to symbolize
GraffitiByNeighborhood, but first, you need to add a Calculate Field tool to the model with
GraffitiByNeighborhood as input. Join_Count has the number of graffiti calls per neighborhood
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and therefore is the attribute for making the choropleth map, except that the Apply Symbology
From Layer tool only allows attributes originally available from the Graffiti point layer for use in
symbolization. As a workaround to this limitation, Graffiti has an attribute called Frequency that
you set equal to Join-Count in the Calculate Field tool. Then you can use the Apply Symbology
From Layer tool to symbolize the choropleth map using Frequency. Use the pre-built layer file,
GraffitiChoropleth.lyrx, available from Chapter12\Assignment12-1\Resources for symbolizing
GraffitiByNeighborhood. Note that that Graffiti Map already has the GraffitiByNeighborhood
map layer. The Apply Symbology From Layer tool only works if the map layer being symbolized
exists in the Contents pane before the model is run. Normally, the Contents pane will have the
previous week’s GraffitiByNeighborhood map layer, so this condition will be met. Here,
however, the map has the current GraffitiByNeighborhood map layer, which your model will
recreate.
Extend the Prepare Graffiti Data for ArcGIS Online task item
Start by publishing the existing copy of GraffitiByNeighborhood in the Contents pane of
the Assignment 12-1 project to your ArcGIS Online account. Then the new Share
GraffitiByNeighborhood Web Layer step below can use the Overwrite Web Layer option for
publishing the same web layer whenever new data is available (or whenever you run the tasks
while designing and debugging).
In the Catalog pane, under Tasks, right-click Prepare Graffiti Data for ArcGIS Online, and
click Edit in Designer to revise and extend tasks and task items according to the following task
item structure. Changes to the structure of the task item are in italics.


a. Prepare Data task.


Enter Date step. Opens the Heading attribute table and guides the user in editing
the Heading date value.



Create Graffiti and GraffitiByNeighborhood Feature Classes step. This step runs
the extended Graffiti Data Import model.




Symbolize the Graffiti and GraffitibyNeighborhood layers.

b. Share Web Layers task.


Share Heading Web Layer step.
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Share Graffiti Web Layer step.



Share GraffitiByNeighborhood Web Layer step.

What to turn in
Create a Word document called Assignment12-1YourName.docx and include screen
shots of the following panes or windows, with each labeled using the names in bold font below.
(Note: you can use any available tool for making screen shots. One available on all Windows
computers is the Snipping Tool. To use it, search for and open Snipping Tool. Click New, drag a
rectangle around the window you wish to snip, click the Save button, and save the resulting
image with a descriptive name and the JPEG file type. You can also use the Snipping Tools
Highlighter or Pen to draw attention to important parts of images. An eraser is available in the
Snipping Tool to remove marks you don’t want to keep.)


Graffiti Data Import model in edit mode.



Opened Spatial Join process, from the Graffiti Data Import model.



Opened Calculate Field process, from the Graffiti Data Import model.



Opened Apply Symbology From Layer process, from the Graffiti Data Import model for
symbolizing GraffitiByNeighborhood.





a. Prepare Data task in edit mode in Task Designer.



b. Share Web Layers task in edit mode in Task Designer.

Share GraffitiByNeighborhood Web Layer step in edit mode in Task Designer.
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Assignment 12-2: Modify and extend the Graffiti Dashboard operation view
The Graffiti Dashboard operation view enables police to study the spatial patterns of
serial graffiti artists. Then police can direct patrols to target areas where graffiti artists are
active to either prevent new graffiti by police presence or to apprehend graffiti artists in action.
The operation view you built in tutorial 12-4 already has some useful queries for this purpose.
In this assignment, you’ll add a new query that highlights all graffiti sites that have artists
identified, and you’ll add a bar chart of the number of graffiti sites by artist.
You need to have completed tutorials 12-3 and 12-4 in order to do this assignment, but
you don’t have to have completed assignment 12-1. The Assignment12-2 project has the
choropleth map of assignment 12-1, which you can publish, if needed, in your ArcGIS Online
account and add to your ArcGIS Online Graffiti Map.
Get set up
If you completed assignment 12-1, you already have the GraffitiByNeighborhood
choropleth map published. If not, open Assignment12-2.aprx in the Chapter12\Assignment12-2
folder and publish its GraffitiByNeighborhood map layer. Then add GraffitiByNeighborhood to
your ArcGIS Online map, GraffitiMap, created in tutorial 12-3. When you open your operation
view, Graffiti Dashboard, in Operations Dashboard for ArcGIS, Graffiti Map will open with the
new choropleth layer. The Legend widget will automatically include the choropleth map.
To get started with Graffiti Dashboard, open that operation view, click Tools, and then
click Edit Operation View.
Configure a new query and bar chart
To the existing Graffiti queries widget, add a query called “Calls with artist names” that
highlights all graffiti calls that have values entered for ARTIST. Run the query to highlight those
graffiti calls.
Remove the Frequency of graffiti type bar chart. Add a new bar chart widget, with
“Graffiti queries Results” as data Source, Display feature counts as bars for Display Type, and
Artist as Value Field. For the bar chart to display information, you need to run the “Calls with
artist names” query first so that some graffiti sites are selected.
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What to turn in
Create a Microsoft Word document called Assignment12-2YourName.docx, and include
screen shots of the following panes or windows, with each labeled using the names in bold font
below. (Note: You can use any available tool for making screen shots. One available on all
Windows computers is the Snipping Tool. To use it, search for and open it. Click New, drag a
rectangle around the window you wish to snip, click the Save button, and save the resulting
image with a descriptive name and the JPEG file type. You can also use the Snipping Tools
Highlighter or Pen to draw attention to important parts of images. An eraser is available in the
Snipping Tool to remove marks you don’t want to keep.)
•

Operation view, with Results for Calls with artist names run and Artist Frequency bar
chart displaying results of the query.

•

Query Definition for Calls, with artist names query, from configure mode of the query
showing its completed condition.

•

Configure Bar Chart, from configure mode of Artist Frequency bar chart.
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Chapter 13
Assignment 13-1: Build models for routing the supervisor’s assessment of new graffiti
The models that you’ll build in this assignment are similar to those of tutorials 13-1 and
13-2. The Public Works supervisor in charge of graffiti removal needs to visit each new graffiti
site to make several assessments, which she records using Collector for ArcGIS® (as configured
in tutorial 13-4). In this assignment, you build ModelBuilder models that the supervisor runs
weekly to get optimal routes for visiting the new graffiti sites.
The volume of new graffiti is low enough and on-site time is short enough so that the
supervisor can visit all new sites in just part of a day. She needs to spend only five to 10 minutes
at each site, so most of her time is spent driving from site to site. There is no need to make a
permanent record of the route, as in tutorial 13-3. Instead, for output, the supervisor just wants
a screenshot of the optimal route map with each graffiti point to be visited labeled with a street
address. Then, if needed, she’ll use her in-car GPS to get driving instructions from one graffiti
site to the next.
One complication is that the supervisor needs two model versions available for routing.
She either starts a route from her home and finishes at the Public Works garage, or she starts
and finishes a route at the garage. To handle this need, you’ll build a model called “b1.
Calculate Optimal Route Starting from Home” for starting a route at her home and a second
model called “b2. Calculate Optimal Route model Starting from Garage” for starting a route at
the garage. Hint: Build “b1. Calculate Optimal Route Starting from Home”, then copy and paste
it in the Catalog pane, and modify the copy to be model “b2. Calculate Optimal Route model
Starting from Garage”.
Get set up
Rename the Chapter13\Assignment13-1 folder to Assignment13-1YourName. Open
Assignment13-1.aprx.The map has map layers from the GraffitiCalls and Garage feature classes
and the PittsburghStreets_ND network dataset that you will use in tutorials 13-2 and 13-3 of
this chapter.
Build the models
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This model, “a. Identify New Graffiti”, is similar to the model of tutorial 13-1 except that
you have to design criteria to identify new graffiti. Choose a symbolization graffiti points, which
must be different than in tutorial 13-1 because graffiti is not classified by type until the
supervisor inspects graffiti sites. Save the symbolization as a layer file in your Assignment13-1
folder for use in the a. Identify New Graffiti model.
The “b1. Calculate Optimal Route Starting from Home” model and “b2. Calculate
Optimal Route Starting from Garage” are similar to that of tutorial 13-2 except that the Home
point is used as the starting point in the b2 model. Remember to use PittsburghStreets_ND as
the Network Data Source.
What to turn in


Create a Word document called Assignment13-1YourName.docx. Type Assignment13-1
and your name at the top. First, create a section called Models and include the following
screenshots from your model:


Finished a. Identify New Graffiti model—the valid model ready to run



Make Feature Layer—the opened Make Feature Layer process showing its query
expression



Finished b1. Calculate Optimal Route Starting from Home model—the valid model
ready to run



Next include a section called Optimal Routes with the optimal route for that case.


The optimal route starting from home—the map with optimal route starting from
home and ending at the garage



The optimal route starting from the garage—the map with optimal route starting
from and ending at the garage
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Assignment 13-2: Create a Collector map for the Public Works employee who removes
graffiti
When public works employees go out on a route and remove graffiti from a site, they
must update or record data. In particular, they must input or revise data for the following
attributes:


Work_Time_Actual (record)



Date_Finished (record)



Removal_Type_Code (possibly update)



Graffiti_Type_Code (possibly update)



Artist (possibly record or update)



Comment (possibly record)
Your assignment is to create a Collector for ArcGIS® application for this purpose. Note:

At the time of writing this assignment, Collector did not display layer labels created in ArcGIS
Online. At some future point, it will be desirable to include the stops layer from optimal routing
and use its sequence number for stops as a label, along with Address as a label for graffiti calls.
Get set up
Rename the Chapter13\Assignment13-2 folder to Assignment13-2YourName. Open
Assignment13-2.aprx.The map has the following layers:


GraffitiCalls2 is the master layer of all graffiti calls, historical and current. The calls for the
current route are indicated with the attribute condition, Current_Route = Yes.



Routes has the optimal route for display purposes.



Stops has the sequence of stops of the optimal route. This layer is included for future use
when Collector can display feature labels. Then the Stops Sequence attribute would serve as
the label.
Rename GraffitiCalls2 to be GraffitiCallsYourName, substituting your name for

YourName. Use the Rename tool for this purpose. Change the name in Contents also to be
GraffitiCallsYourName. Similarly, rename Routes to be RoutesYourName.
Create code-value domains
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Re-create the RemovalType and GraffitiType domains from tutorial 13-4. In addition
include a new graffiti type, “Blockbuster” (blockbuster graffiti covers large areas, often includes
large block letters, and often is painted with a roller). Then apply the domains to
Removal_Type_Code and Graffiti_Type_Code in the GraffitiCallsYourName feature class.
Publish web layers and configure your map on ArcGIS Online


Share the GraffitiCallsYourName and RoutesYourName feature classes as web layers in your
ArcGIS Online account. Add those layers to an ArcGIS Online map you save as Graffiti Calls
for Removal.



Make Streets the basemap.



Add the following filter to GraffitiCallsYourName:


Current_Route is Yes.



Enable editing of the GraffitiCallsYourName web layer.



Create pop-ups for GraffitiCallsYourName that have the needed attributes for input of
updating as well as Address for identification and Work_Time_Estimate for reference.

Update records
Following are the changes that the employee who removes graffiti would make on his
route. Using Collector, just make the changes for the 3374 NIAGARA ST record.

What to turn in
Create a Word document, Assignment13-2YourName.docx. Type Assignment13-2 and
your name at the top. Then include the following screenshots labeled as follows:


Finished domain for RemovalType showing code values.



Finished domain for GraffitiType showing code values.
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Graffiti Calls for Removal map showing the ArcGIS Online map with graffiti sites and
route.



Collector edit session screenshot from your mobile device (Android, Apple, or
Windows 10) of your completed edits in the Collector edit form for the 3374
NIAGARA ST location. E-mail or otherwise get a copy of the resulting image to
include.

